
Name Description Values

accuracy_lower_bound
Enter an accuracy value to override the default lower limit. The minimum value for relative 
accuracy is 1E-06.

acis_out_version Allows the user to choose ACIS export version. 4, 5
activate_sketch_with_dflt Activate sketcher automatically using system defaults. yes / no

add_java_class_path
Prepends the option value on the java environment variable, CLASSPATH, used to find classes in 
J-Link programs. To specify multiple search paths in the same line, delimit them using ':' on UNIX, 
and ';' on Windows NT.

add_weld_mp
Yes - System includes welds when calculating mass properties. No - System excludes welds when 
calculating mass properties.

yes / no

aec_parameter_file Specifies the file name of the user defined piping parameter codes.
align_cable_bundles Align NEWLY CREATED bundles where they meet or branch out yes / no

allow_anatomic_features
Setting this configuration option to yes makes the following commands available when you click 
Insert > Advanced: Local Push, Radius Dome,Section Dome, Ear, Lip, Slot, Shaft, Flange, Neck.

yes / no

allow_confirm_window
Display a confirmation window when exiting Pro/ENGINEER. This enables you to use the mouse 
to confirm/cancel exiting Pro/ENGINEER.

yes / no

allow_float_opt_checkout Yes - Allows checkout failure for floating modules. no / yes

allow_move_attach_in_dtl_move
Yes - Move and Move Attach commands in drawing mode act together. No - Move and Move 
Attach commands in drawing mode do not act together.

yes / no

allow_move_view_with_move Disallow the movement of drawing views with the mouse. yes / no

allow_package_children
Sets what type of children packaged components can have. ALL - Features and components can 
be a children of packaged component. FEAT - Only features can be children of packaged 
components. NONE - Packaged components cannot have children.

all / feat / none

allow_ply_cross_section Yes - Enables Pro/COMPOSITE to create a cross-section of composite plys. yes / no
allow_redo_intersections Yes - Displays the ReIntersect command in the ASSY FEAT menu. yes / no

allow_ref_scope_change
No - Displays the message "Reference scope changes are prohibited by the configuration file 
settings" when the Ref Scope user interface is changed.

yes / no

allow_refs_to_geom_reps_in_drws
Yes - Allows you to create drawing references to geometry representations (includes dimensions, 
notes, and leaders). These references may become invalid if the referenced geometry changes 
resulting in geometry representations not updating in drawings.

yes / no

allow_rfs_default_gtols_always Yes - Enables RFS/Default gtols to be created even when not permitted by ANSI standard. no / yes
allow_save_as_instance Allows the option to save a copy of the active model as a family table instance. yes / no

Pro/ENGINEER® Wildfire™ Configuration Options

The following table lists the configuration options for Pro/ENGINEER Wildfire. Descriptions and possible values for each option are provided. The first value 
listed is the default.  For more information on setting and using configuration options, see the Pro/ENGINEER Help Center or click Tools > Options in 
Pro/ENGINEER.
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Name Description Values

allow_sketch_selection
Yes - An external sketch may be selected as the feature's section. The sketch is copied into the 
feature without an associative link. No - An external sketch may not be selected as the feature's 
section.

yes / no

allow_udf_style_cosm_threads
Defines the Cosmetic Thread user interface. Yes - Creates a Cosmetic Thread as a UDF. No - 
Creates a Cosmetic Thread as a Cosmetic Thread feature.

yes / no

allow_workpiece_silhouette
Determines if the workpiece is allowed for Silhouette Mach Window creation. NO - only reference 
part is allowed; YES - both workpiece and reference part are allowed; AUTO - only workpiece is 
allowed.

yes / no / auto

ang_dim_in_screen
Yes - If the display is in the default pan/zoom setting (View>Pan/Zoom>Reset), the system checks 
whether an angular dimension is visible on the screen. If it is not visible, then the system moves 
the dimension to a visible location.

yes / no

ang_units
Sets the display of angular dimensions to decimal degrees (ang_deg), degrees and decimal 
minutes (ang_min) or degrees, minutes and decimal seconds (ang_sec).

ang_deg / ang_min / ang_sec

angle_grid_interval Modify grid space in angular units for handle movement.

angular_tol
An alternative format for setting default angular tolerance dimensions. The value sets the number 
of decimal places, and the tolerance is the actual tolerance value. For integer dimensions, the 
value is zero, and the tolerance is an integer.

angular_tol_0.0
Sets the default tolerance for angular dimensions. Each option sets a tolerance for a specific 
decimal place. The value is the place of the last decimal.

angular_tol_0.00
Sets the default tolerance for angular dimensions. Each option sets a tolerance for a specific 
decimal place. The value is the place of the last decimal.

angular_tol_0.000
Sets the default tolerance for angular dimensions. Each option sets a tolerance for a specific 
decimal place. The value is the place of the last decimal.

angular_tol_0.0000
Sets the default tolerance for angular dimensions. Each option sets a tolerance for a specific 
decimal place. The value is the place of the last decimal.

angular_tol_0.00000
Sets the default tolerance for angular dimensions. Each option sets a tolerance for a specific 
decimal place. The value is the place of the last decimal.

angular_tol_0.000000
Sets the default tolerance for angular dimensions. Each option sets a tolerance for a specific 
decimal place. The value is the place of the last decimal.

arc_radius_limit
Sets the upper limit for a radius in a CIRCLE statement of NCL file. The value must be positive. If 
not, 10*part_size is used.

assy_mfg_open_mode No Default Application set for opening Assembly NC Models.
none / mfg / process / feature / 
toolmaker

atb_auto_check_on_activate Sets state of ATB 'Auto Check Status On Activate' toggle. on / off
atb_auto_check_on_retrieve Sets state of ATB 'Auto Check Status On Retrieve' toggle. on / off
atb_auto_check_on_update Sets state of ATB 'Auto Check Status On Update' toggle. on / off
atb_ident_cadds_files Allows to identify CADDS files in the file open browser. yes / no
atb_search_path Extends search path for ATB Update and ATB Check Status commands.
atb_show_log Sets state of ATB 'Show Log' toggle. on / off
attach_menumanager Setup menu manager attachment to the main Pro/E window. yes / no
auto_assembly_with_layouts Yes - Enables automatic assembly. No - Disables automatic assembly. yes / no
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Name Description Values

auto_associate_dimensions
Yes - The drawing setup option associative_dimensioning is also set to Yes. The system tries to 
associate imported IGES dimensions (not yet associative) with corresponding imported geometry.

no / yes

auto_constr_always_use_offset
Control whether auto constraint should create offsets. Yes - Auto constraint always creates offsets. 
No - Auto constraint snaps align or mate if surfaces are within tolerance.

yes / no / never

auto_constr_offset_tolerance
Sets the auto constraint tolerance for creating offset dimensions. If distance is less than this 
tolerance multiplied by component size, offset is set as coincident. Default value is 0.5 .

auto_convert_cables
Yes - When regenerating a pre-Release 11.0 cabling assembly, the system automatically creates 
a separate spool feature for every individual wire or cable in the assembly. No - An interface for 
the cable conversion appears.

yes / no

auto_regen_views
Yes - Automatically repaints the drawing display when changing from one window to another. No - 
Update the drawing only. Click View>Regen View>Pick View>Current Sheet or All Sheets. Neither 
Repaint nor Regenerate update the drawing.

yes / no

auto_xml_on_retrieve
Automatically load Cabling Logical Reference from an XML file when retrieving the cabling 
assembly

yes / no

auto_xml_on_save Automatically create an XML Logical Reference when saving a cabling assembly yes / no
autodrill_udf_dir Storage directory for holemaking MUDF's that are used by Pro/NC Auto-drilling functionality
autodrilling_config_filename Retrieve automatically and load the configuration file for the auto-drilling table.

autodrilling_holestyle_param
Parameter name included in hole features of a manufacturing reference model. The parameter 
value identifies the MUDF for holemaking that is automatically applied in Pro/NC to drill these 
holes.

autoplace_single_comp
Assembling components with an interface will automatically place the component at the first 
position satisfying the interface definitions.

no / yes

autoroute_path_param_name Set the wire parameter to use to select a path during autorouting.

bell
Yes - Turns on the keyboard bell that rings after each prompt. No - Turns off the keyboard bell. To 
override this setting use the Environment dialog box on the Tools menu.

yes / no

bitmap_size
Works in conjunction with save_bitmap. Determines the size (squared) of the bitmap image that is 
stored.

blank_layer Blanks specified layers when you begin a Pro/ENGINEER session. The value is the layer ID.

blended_transparency
Yes - Transparent colors will appear using alpha blending (if supported) when the model is 
shaded.

no / yes

bm_graph_tool BMX graph tool default / generic_graphtool
bmgr_pref_file Specifies the location of the Graph Tool preference file.
bom_format Sets the BOM format file to be used for a customized BOM. Specify name and path.

browser_favorite
Specifies the directories visible in the file browser for quick navigation. Use the full path to avoid 
problems.

bump_revnum_on_retr_regen
Determines whether or not revnum is increased for generic models that regenerate and change 
during assembly retrieval. Only applies if new_asm_regen_revnums is yes (otherwise, there will 
be no revnum bumping).

yes / no
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Name Description Values

button_name_in_help
Yes - The name and menu of any selected menu option displays, in English, in the help text 
associated with that button.

yes / no

cable_int_portions_for_clr
No - Global clearance checking for internal cable portions is excluded. Yes - Global clearance 
checking for internal cable portions is included.

no / yes

cadam_line_weights
Define the line width of entities within Pro/ENGINEER to plot drawings with correct line weights 
that are consistent with a standard. The default Pro/ENGINEER values for these weights are: 2 
(light), 3 (medium), 5 (heavy).

cadds_import_layer Allows import of CADDS5 layering. yes / no

campost_dir
Specifies the CAM-Post load point directory to enable you to directly set-up the post-processors 
and generate MCD files.

can_snap_to_missing_ref
Controls whether to enable snapping to missing references while dragging components for 
placement. Yes - Snapping is enabled while dragging. No - Snapping is disabled while dragging.

yes / no

capped_clip
Yes - Displays the model as a solid when shaded and clipped. No - Displays the model as 
surfaces when shaded and clipped.

no / yes

catia_out_to_existing_model
Append - If the selected CATIA model already exists, the new data is appended to the existing 
CATIA file. Overwrite - If the selected CATIA model already exists, the newly exported file 
overwrites the existing one.

append / overwrite

catia_translator
Allows the user to choose between the old CATIA license-based converter (pro_cat) and the new 
non-CATIA license based (cat_ii) converters when doing direct import/export of CATIA files. When 
"topobus_enable" is set to "yes", cat_ii will be always used.

cat_ii / pro_cat

cdt_transfer_details
No - Details (dittos) associated with the imported CADAM drawing are placed on the current 
Pro/ENGINEER drawing sheet. Yes - Each detail (ditto) associated with the imported CADAM 
drawing converts to a separate additional sheet.

yes / no

centimeter_grid_interval Modify grid space in centimeter units for handle movement.
cgm_inc_pad_byte_in_length Yes - Enables a metafile to be processed by the Micrographic CGM converter. yes / no
cgm_use_enum_in_real_spec Yes - Enables a metafile to be viewed in Advanced Technology Center's ForReview. yes / no
cgm_use_reversed_ieee_floats Yes - Enables a metafile to be viewed in Advanced Technology Center's ForReview. yes / no

chamfer_45deg_dim_text
Controls the display of chamfer dimension text without affecting the leader. This only affects the 
text of newly created dimensions. ASME/ANSI is the default.

asme/ansi / iso/din / jis

check_intralink_attributes Specify whether intralink attributes should be checked or not. yes / no

check_same_assy_parts
Determines whether to permit different names for different part occurrences, or not in mirror 
subassembly UI.

yes / no

chk_part_surfs_profpock
Yes - Includes all reference part surfaces as check surfaces for profiling and pocketing NC 
sequences.

yes / no

cl_arrow_scale
Enables you to control the size of the tool path arrow for contouring NC sequences. 0 - The arrow 
does not display. Any other value - The arrow scales accordingly.

cl_rotate_sign_convention
TOOL or TABLE - defines ROTATE sign direction convention based with respect to either rotation 
table or cutting tool.

table / tool

clearance_triangulation
Specifies the quality of surface triangulation used to obtain initial guess points for clearance and 
interference calculations.

none / low / medium / high

clip_always Yes - Display clipping after Visibilities dialog box is closed. no / yes
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Name Description Values
clock Yes - Displays the clock while Pro/ENGINEER is working. yes / no

clr_print_plus_minus
Sets the display of the system accuracy when calculating clearances between two parts or 
surfaces. The default is to not display the accuracy.

yes / no

cmdmgr_trail_output
Trail file and mapkey output will include system instructions that are independent of user interface 
configuration when available (typically menu bar and toolbar options).

yes / no

color Turns the colors on or off. Turning colors off displays the model wireframe in white. no / yes

color_ramp_size
Specifies the number of shades in a color ramp. Applicable to multi-color, shaded model displays 
of simulation / analysis results. System graphics must support 256 colors and color maps that 
compress.

color_resolution
Specifies minimum allowable deviation between user-defined colors. Colors having RGB values 
within tolerance of existing colors cannot be created. Decreasing this setting allows more colors 
that are very similar in RGB value to be defined.

color_windows
All_windows - Wireframe colors display in the main window and all auxiliary windows. 
One_window - Colors display only in the main window. Auxiliary windows display wireframe in the 
default color.

all_windows / one_window

comp_angle_offset_eps
Specifies the angle epsilon such that if the desired surfaces are equal or greater than the epsilon 
(in degrees), than an angle offset constraint will be created.

comp_assemble_start
Constrain_in_window - New assembly components are shown in a separate window and must be 
constrained within the assembly. Package - New assembly components are shown within the 
assembly as a packaged component.

package / constrain_in_window

comp_offset_dec_places
Sets the default number of decimal places (0-10) to display in the offset column of component 
placement.

comp_rollback_on_redef No - Assembly is not rolled back when the user redefines a component. yes / no

comp_snap_angle_tolerance
Specify the angle tolerance for snapping while freeform dragging components. Default value is 
30.0 degrees.

comp_snap_dist_tolerance
Specify the distance tolerance for snapping while freeform dragging components. Default value is 
0.1 (relative to size of component being assembled).

company_name
Used with the export option iges_out_mil_d_28000. To support MIL-D-28000, your company name 
is required input and the system prompts you every time you export through IGES unless you set 
the company name in your configuration file.

compress_output_files
You can compress object files to store them. Compressed files are slower to read and write, one-
half to one-third the size, and fully compatible across systems. Yes - Stores object files in 
compressed format. No - Object files are not compressed.

yes / no

conf_mouse_anim Display the presenter's mouse motions when observing a shared Pro/ENGINEER session. no / yes

copy_dxf_dim_pict
YES - Imports each component of AutoCAD dimension separately. NO - Imports AutoCAD 
dimensions as dimensions in Pro/ENGINEER. AS_SYMBOL - Imports AutoCAD dimensions as 
symbols in Pro/ENGINEER.

yes / no / as_symbol

copy_geom_update_pre_2000i_dep
Yes - Flags independent copy geom features in a pre-2000i model as modified when retrieved into 
Pro/ENGINEER. Save the model immediately to update the model's copy geom dependency 
information.

no / yes

cpus_to_use Set up the number of threads including main thread
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Name Description Values

create_drawing_dims_only
Yes - Saves all new dimensions created in the drawing (regardless of the drawing setup file 
option) inside the drawing as associative draft dimensions. No - Saves all dimensions created in 
Drawing mode in the part.

yes / no

create_fraction_dim Yes - All dimensions created will be displayed as fractions. yes / no
create_numbered_layers Yes - Creates default layers named 1 through 32. yes / no
create_temp_interfaces Allow the automatic creation of interfaces based on previous assembly instructions. yes / no
curr_proc_comp_def_color Specifies the default color used to display the current component in a process assembly.
curr_proc_comp_def_font Specifies the default font used on the current component in a process assembly.

custom_rainbow
Used to specify fringe colors in Pro/FEM-POST results. Specify blue, black, cyan, magenta, green, 
yellow, red, and white. Enter colors as a dash-delimited string (lowest to highest value). The 
default is blue-cyan-green-yellow-red-magenta-white.

datum_point_symbol Specifies the shape of datum point symbols displayed in Part or Assembly mode.
dot / cross / circle / triangle / 
square

dazix_default_placement_unit Specifies the units to be used for data imported in Dazix files. micron / mm / thou

dazix_export_mounthole
Yes - Causes the MOUNTHOLE section of a Dazix file to be processed as a mount hole. No - 
Causes the MOUNTHOLE section to be processed as a cut.

yes / no

dazix_z_translation Yes - Passes the objects in the .edn files through z translation. yes / no

def_layer
Specifies default layer names for different types of items. The first value string is the layer type. 
The second value string is the layer name.

default_abs_accuracy Defines the default absolute part accuracy.
default_ang_dec_places Specifies the number of decimal places shown in angular dimensions in a drawing.

default_comp_geom_scope Set thespecified Shared Geometry reference control conditions to newly added components. all / pg / none

default_comp_invalid_refs
Set the specified handling method of out-of-scope Accessible references to newly added 
components.

copy / prohibit

default_comp_scope_setting Set the specified Accessible reference control conditions to newly added components.
all / none / subassemblies / 
skeleton_model

default_comp_skel_geom_scope
Set the specified Shared Geometry reference control conditions to newly added Skeleton 
components.

all / pg / none

default_comp_skel_scope_setting Set the specified Accessible reference control conditions to newly added Skeleton components.
all / none / subassemblies / 
skeleton_model

default_dec_places
Sets the default number of decimal places (0-14) to display in all model modes for non-angular 
dimensions. It does not affect the display of dimensions modified using Num Digits. In Sketcher, 
sketcher_dec_places controls the number of decimal places.

default_dim_num_digits_changes
Sets the default number of digits displayed in a dimension to the last entered value. No - The 
system defaults to the value specified for the configuration file option default_dec_places.

yes / no

default_draw_scale
Sets the default drawing scale for views added with the No Scale command. The value must be 
greater than 0. No - The system does not set a default drawing scale.

default_ext_ref_scope
Set default scope for externally referenced models. All - Any model. None - Only current model 
and children. Skeletons - Any component in model's assembly and higher skeletons on branch. 
Subassembly - Only components and children in model's assembly.

all / none / subassemblies / 
skeleton_model
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Name Description Values

default_font
Sets font for text other than menu bar, menus and their children, and pop-up menus and help. Add 
comma-delimited variables in any order (italic bold, 24, times or 24, times, italic bold have the 
same effect). Any omitted variable uses standard setting.

default_geom_scope Default value for Geometry Scope allowed for referencing. all / pg_if_exists / pg_only

default_mold_base_vendor Default Value for Mold Base vendor.
futaba_mm / dme / hasco / 
dme_mm / hasco_mm

default_obj_constraints_scope
Set the specified Shared Placement reference control conditions to newly created models if 
template models were not used.

all / interfaces / none

default_object_geom_scope
Set the specified Shared Geometry reference control conditions to newly created models if 
template models were not used.

all / pg / none

default_object_invalid_refs
Sets default condition for reference handling. Prohibit - System will abort all attempts to create ext. 
reference that violates scope. Copy - System will issue warning upon all attempts to create ext. 
reference that violates scope.

copy / prohibit

default_object_scope_setting
Set default condition for reference control. All - Any model. None - Only current model and 
children. Skeletons - Any component in model's assembly ang higher skeletons on branch. 
Subassembly - Only components and children in model's assembly.

all / none / subassemblies / 
skeleton_model

default_placement_scope Default value for Component Placement Reference filter. all / intrf_if_exists / intrf_only
default_ramp_size Specifies a number of shades of gray to show shading of non-colored objects.

delete_after_plotting
Yes - A plot file is automatically deleted from the directory in which it resides when it has been 
successfully plotted.

yes / no

depthcue_always
Depth cue aids in visualizing a wireframe model. With depth cue enabled, wireframe lines become 
darker as they extend into the screen and lighter as they extend towards the screen. Depth cue is 
supported only by the appropriate graphics hardware.

no / yes

depthcue_value
Aids in visualizing a wireframe model. With depth cue enabled, this option specifies the default 
percentage of depthcue used. Depth cue is supported only by the appropriate graphics hardware.

diagram_pin_edit_multi_line
(Diagram) Determines the Pro/TABLE format used when you are modifying pin parameters. "yes" - 
You can add user-defined pin parameters by including them between the DEFINE and ENDDEF 
statements for each pin. "no" - The system uses columnar format and

yes / no

dialog_translation
Specifies the language in which the dialog display when running non-English version of 
Pro/ENGINEER.

yes / no

dim_fraction_denominator
Sets the largest denominator to be used for fractional dimensions. If the fraction can be reduced, 
then it converts to the lowest possible denominator (for example, 4/32 converts to 1/8).

dim_fraction_format
Std - Displays fractional dimensions in the standard Pro/ENGINEER format. Aisc - Displays 
fractional dimensions in the American Institute of Steel Construction (AISC) format and displays 
architectural units in AISC format for feet-inches.

std / aisc

dim_offscreen_limit
If more than zero, sets the margin beyond which dimensions are automatically snapped back onto 
the screen. For example, a value of .2 lets a dimension be 20% of the window size outside the 
window. If set to zero, disables snapping of offscreen dimensions.

dir_cache_max
Specify the maximum number of directories to cache. Larger values can speed up file access, but 
use more memory.
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Name Description Values
direct_vrml Yes - Enables direct VRML conversion. yes / no

disable_search_path_check
Controls whether the search path is checked for name conflicts when creating, renaming, or 
copying models. Name conflicts should be avoided because different models with the same name 
cannot be together in session.

yes / no

disp_in_open_rep_create
Simplified Rep to display initially in Open Rep Create: "No" for none, "Yes" for graphics rep, or 
"Default Rep" to display the rep indicated by option "open_simplified_rep_by_default".

yes / default rep / no

disp_trimetric_dwg_mode_view
Displays the model in default orientation when placing a general view on the drawing. No - Model 
does not appear until Default is chosen from the Orientation dialog box.

yes / no

display
Wireframe - Displays model with all lines in white. Hiddenvis -Hidden lines in grey. Hiddeninvis - 
All hidden lines removed. Shade - All models (except drawing) with all surfaces shaded. Line 
display is reflected in plotter, DXF and IGES files.

wireframe / hiddenvis / hiddeninvis 
/ shade

display_axes Displays or hides datum axes. yes / no
display_axis_tags Displays or hides datum axis name tags. yes / no

display_comps_to_assemble
Yes - The design model goes into memory and displays. Pick process components from the 
design model or the Model Tree. No - Only the Model Tree displays. As you pick process 
components from the Model Tree, they go into memory.

yes / no

display_coord_sys Yes - Coordinate systems will be displayed. No - Coordinate systems will not be displayed. yes / no

display_coord_sys_tags
Yes - Coordinate system name tags will be displayed. No - Coordinate system name tags will not 
be displayed.

yes / no

display_dwg_sketch_constraint
When set to yes, parametric sketching constraints, such as V for vertical, are displayed when a 
drawing object is selected

yes / no

display_dwg_tol_tags
Sets the display of the tolerance tags that appear in drawings. This option does not affect the 
display of tolerances on dimensions.

yes / no

display_florin
Yes: display of the florin (international currency symbol) where possible. No: use the euro symbol 
exclusively.

no / yes

display_full_object_path
Controls the display of the object's full file name (including its object-type suffix and its version 
number) and file path in the window title and Model Info display. Yes - Displays full file name and 
file path. No - Displays object name only.

no / yes

display_in_adding_view
Controls model display in a drawing when auto_regen_views is No. Wireframe - Adds new views 
in wireframe, displays datums. Minimal_wireframe - Displays in wireframe, no datums, axes, or 
silhouette edges. Default - Displays using the Environment setting.

wireframe / minimal_wireframe / 
default

display_internal_cable_portion
Yes - Internal cable portions will be displayed for any wires that have been manually set to Yes in 
the Cable Paths Setup dialog box for each individual splice and custom component. This option 
can be overridden in the Environment dialog box.

yes / no

display_layer
This causes the specified layers to display when you begin a Pro/ENGINEER session. The 
variable "value" is the layer Id.

display_plane_tags Yes - Datum plane name tags will be displayed. No - Datum plane name tags will not be displayed. yes / no

display_planes Yes - Datum planes will be displayed. No - Datum planes will not be displayed. yes / no
display_point_tags Yes - Datum point tags will be displayed. No - Datum point tags will not be displayed. yes / no

display_points
Yes - Datum points and their names will be displayed. No - Datum points and their names will not 
be displayed.

yes / no
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display_silhouette_edges Sets the display of silhouette edges for wireframe display only. yes / no

display_thick_cables
Yes - Display cables and wires with thickness. No - Display the centerline of cables and wires only. 
This option can be overridden in the Environment dialog box.

yes / no

display_tol_by_1000 If set to Yes, tolerances for non-angular dimensions will be displayed multiplied by 1000. yes / no

dm_cache_mode Indicate which objects will be written to local cache when objects in Pro/E memory are saved. none / modified / all

dm_cache_size Enter amount of disk space (in megabytes) to allocate for local file storage.

dm_http_compression_level

ND files will be compressed before being sent for upload by setting the value of config.pro option 
'dm_http_compression_level' to a value between 1 and 9. If the value is not set or a 0-value is set, 
it means no-compression. This change can speed up the Upload operation for a client connected 
to a Windchill server over a slow network.

dm_remember_server Primary server/workspace must be set by user for each Pro/E session. no / yes

dm_secondary_upload
Indicate when modified Pro/E objects on a secondary server will be moved from the local cache to 
the user's workspace on the server.

automatic / explicit

dm_upload_objects
Indicate when modified Pro/E objects will be moved from the local cache to the user workspace on 
the server.

automatic / explicit

dont_show_symbol_nodes Do not show references derived from relations in Parent/Child viewer. yes / no

draw_models_read_only
Yes - Drawing model files are read-only (i.e. they cannot be modified). You cannot add driven 
dimensions, geometric tolerances, or similar items to the models.

yes / no

draw_points_in_model_units
Defines the current draft view's coordinate values as model units rather than drawing units. The 
GET POINT menu uses the scale of the draft view and the draft view's model units for relative and 
absolute coordinate entry and display in the Message Window.

yes / no

drawing_file_editor
Specifies the default text editor for the drawing setup file, otherwise, the system uses the default 
editor. Protab - the system uses Pro/TABLE. Editor - system uses the system editor (refer to 
pro_editor_command).

protab / editor

drawing_setup_file
Sets the default drawing setup file option values for your Pro/ENGINEER session, otherwise, the 
system uses the default drawing setup file option values. Certain parameters in the file are valid 
only if you have a license for Pro/DETAIL.

drawing_view_origin_csys
The named coordinate system will be used as the origin of a newly created view or of a modified 
view. None - The system will not use a previously specified coordinate system.

none /

dwg_export_format Provides the ability to choose DWG file version when exporting from Pro/E drawing. 12 / 13 / 14

dxf_block_to_pro_symbol
Specifies whether or not DXF BLOCKS to be imported as Pro/E symbols. Yes - Imports BLOCKS 
as symbol definitions, No - Imports BLOCKS as separate entities.

yes / no

dxf_export_format Provides the ability to choose DXF file version when exporting from Pro/E drawing. 12 / 13 / 14
dxf_export_mapping_file Specifies the DXF export mapping file. Absolute or relative path to the file can be used.
dxf_in_faceted_brep Default, faceted boundary representation is allowed in import. yes / no

dxf_out_comments
YES - comments (999 group codes) will be created in DXF file exported from PRO/ENGINEER. 
NO - DXF file will be created without comment lines.

yes / no

dxf_out_drawing_scale
Specify whether or not to export drawing scale to the DXF or DWG file. Yes - Includes a scale 
factor DIMLFAC in the exported DXF/DWG. No - Exports without using a scale for the drawing. 
Set to Yes when exporting to read into AutoCAD.

yes / no
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dxf_out_scale_views
Specify whether or not to scale drawing views when exporting to the DXF or DWG file. Yes - 
rescales the entire drawing in such a way that the main view scale becomes 1:1. No - exports 
without rescaling.

yes / no

dxf_out_sep_dim_w_breaks
YES - Breaks dimensions with breaks on witness lines to separate entities and preserves the 
original picture. No - Exports such dimensions as DXF DIMENSION entities and removes the 
breaks on witness lines.

yes / no

dxf_out_stroke_text
Strokes == text is converted to lines and dots. Yes - Strokes out text in DXF or DWG export. No - 
Does not stroke out the text for export.

yes / no

dxfio_in_sjis Determines if the SJIS is supported when importing/exporting DXF files in Japanese yes / no

ecad_area_default_import
Defines how imported ECAD areas are treated. Cosm_area - Treats imported ECAD areas as 
cosmetic area features. 3d_volume - Imports ECAD areas with Z-heights as a 3D enclosed quilt.

3d_volume / cosm_area

ecad_board_csys_def_name
Specifies the default coordinate system name added to an ECAD board being imported. If you do 
not set this variable, the system prompts you for a name.

ecad_comp_csys_def_name
Specifies the default coordinate system name added to an ECAD component being imported. If 
you do not set this variable, the system prompts you for a name.

ecad_comp_layer_map Allow layer mapping for ECAD component's import into Assembly. yes / no

ecad_create_hint_add
Assists in creation of an ecad_hint.map file. Yes - Automatically renames components, if 
necessary, each time library of component outlines is imported to Pro/ENGINEER. This does not 
create an ecad_hint.map file. It controls if ecad_hint.add is created.

no / yes

ecad_default_comp_height
Sets default value and units for an ECAD component being imported. Units can be: inch, mil (1E-3 
inches), thou (1E-6 inches), cm, mm, micron (1E-6 meters), dsu (1E-8 meters). If not set, the 
system uses the current component's units.

ecad_default_comp_place_status Sets default component placement status for export (parameter setting will override the default).
unplaced / fixed / placed / mcad / 
ecad

ecad_exp_both_two_areas
Supports the export of ECAD areas with different "Above Board" and "Below Board" conditions. 
"yes" - Enables you to export both sided keep-in/keep-out ECAD areas as two individual areas (top 
and bottom).

yes / no

ecad_export_holes_as_cuts Exports Pro/ENGINEER holes as cuts to ECAD systems. yes / no

ecad_import_holes_as_features
Import sections specified as DRILLED_HOLE as through-all holes. Boards created with 
Pro/ENGINEER drilled holes export with default value of NPTH for the ECAD_HOLE_TYPE 
parameter. Create this feature parameter if a value of PTH is needed (IDF 2.0/3.0).

yes / no

ecad_mapping_file Specify the ecad_hint.map file that will be used for ECAD operations.
ecad_missing_component_status Setup default status for missing components in "Investigate Placement" Dialog. keep_missing / delete_missing

ecad_other_outl_csys_def_name
Specifies the default coordinate system name for the .OTHER_OUTLINE section of an IDF 2.0 
ECAD component being imported. If you do set this variable, the system prompts you for a name.

ecad_panel_csys_def_name
Specifies the default coordinate system name added to an ECAD panel being imported. If you do 
not set this variable, the system prompts you for a name.

edge_display_quality
Controls display quality of an edge for wireframe and hidden-line removal. Normal - Normal quality 
of edge display. High - Increases tessellation by 2. Very_high - Increases tessellation by 3. Low - 
Decreases tessellation from normal, speeds up display.

normal / high / very_high / low
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enable_absolute_accuracy
Controls display of the ACCURACY menu. Yes - ACCURACY menu always appears when you 
choose Accuracy from the PART SETUP menu. No - The menu appears only if the part is 
currently defined with absolute accuracy.

yes / no

enable_assembly_accuracy No - Disables accuracy modification for assembly objects. yes / no

enable_cadra_export
Enables the CADRA command in the EXPORT menu. This enables the creation of a CADRA 
specific IGES file.

no / yes

enable_hlr_hashing Enables hlr hashing no / yes
enable_popup_help Controls pop-up help in dialog boxes. Yes - Help enabled. No - Help disabled. yes / no
enable_tree_indep Setup whether tree customization will allow separating the tree window from Pro/E window. yes / no

erv_show_external_only
Yes - Global Reference Viewer will show objects with external references only; No - all the objects 
will be visible

yes / no

excel_analysis_directory
Sets the default directory for the MS Excel files to be used for Excel analysis calculations. Use the 
full pathname to avoid problems.

exec_prog_on_assem_retr Execute pro/program for models during assembly retrieval. yes / no

explode_iges_dimension_note
Controls how dimensions are treated when importing an IGES drawing file. Yes - Each IGES 
dimension explodes into an independent note with the dimension text and a dimension with an 
empty note. No - Dimensions are treated as before.

yes / no

export_3d_force_default_naming
Specify whether the Pro/ENGINEER file names should be used for export to STEP (only). Yes - 
Do not prompt for a new name. No - Prompt for the name of each STEP file.

yes / no

export_to_shipit Enable Ship-it interface export. yes / no
extend_cvpath Extends CVPATH search path for CADDS5 data exchanging.

fail_ref_copy_when_missing_orig
Yes - When using a copied geom feature or a backed-up external reference with the Design 
Manager, and the reference is missing in the original, then the copied geom feature fails. No - The 
feature freezes and does not update.

yes / no

fail_unattached_feature
Handles unattached protrusion and cuts, when retrieving pre-Release 15 models. Yes - When a 
part is retrieved, the system fails an unattached protrusion or cut. No - When a part is retrieved, 
the system does not fail an unattached protrusion or cut.

yes / no

fan_with_network Setup whether the network should be included on flattening a harness. yes / no
fasthlr Specifies whether fast hidden line removal is on/off by default. no / yes

feature_create_auto_begin
In feature creation, determines whether or not the Define button is automatically activated when 
you open the dialog box. Yes - Button is activated automatically. No - You select the button.

yes / no

feature_create_auto_ok
In feature creation, determines whether or not the system activates the dialog box OK button 
automatically when the last required element is defined. Yes - Button is activated automatically. No 
- You select the button.

yes / no

fem_allow_named_mesh_files
Yes - The user will be prompted to select a file to retrieve the mesh from, or enter a file name to 
save the mesh to. No - The user will not be prompted to select or enter a mesh file name.

yes / no

fem_ansys_annotations Toggles transfer of loadcase names to ANSYS. yes / no
fem_ansys_grouping Toggles transfer of groups/layers to ANSYS. yes / no
fem_asp_ratio The value that FEM created elements of aspect ratio are compared against.
fem_default_solver Specifies default solver. ansys / nastran
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Name Description Values
fem_dist_index The value that FEM created elements of distortion indices are compared against.

fem_edge_angle
Sets the minimum acceptable default angle between adjacent element edges. Enter value 
between 0 and 90.

fem_ignore_unpaired
Yes - Unpaired surfaces are ignored when meshing the model, placing you directly into the AFTER 
COMP menu (the CONT MESH menu is skipped).

yes / no

fem_measures Provides access to Simulation Measures in FEM mode. yes / no

fem_mesh_operations
Yes - The menu item Operations appears in the FEM MESH menu, providing access to 
functionalities to manipulate the finite element mesh. No - the menu FEM MESH will not have the 
item Operations.

yes / no

fem_mesh_preserve
Yes - The finite element mesh will be automatically stored in the mesh file upon creation, and 
retrieved on entering the Structure/Thermal. No - The mesh will not be stored or retrieved 
automatically.

yes / no

fem_mid_ratio The value that FEM created elements of mid ratios are compared against.
fem_neutral_version Specifies version number of neutral file.

fem_new_tetra_mesher Yes (default) - Use new FEM Tetrahedral Mesher. No - Use original FEM Tetrahedral Mesher. yes / no

fem_remove_unopposed
Yes - The system ignores unopposed surfaces when meshing the model; the system also 
deselects the UseUnopposed option. No - the system uses the unopposed surfaces in the shell 
model.

yes / no

fem_skew_angle
Sets the maximum acceptable default skew angle value, measured in degrees. Enter a value 
between 0 and 90.

fem_solid_shell_auto_constraint
Yes - Rotational constraints will be created at the interfacing nodes between solids and shells. No - 
The user needs to make sure that the interfacing nodes are not underconstrained (like adding 
beams). Ask - Prompt the user before running.

yes / no / ask

fem_solver_time_limit
For NASTRAN solution, uses this option to interrupt the solver after the specified time limit. The 
default value is 60 minutes.

fem_taper Sets the minimum acceptable default taper value. Enter a value between 0 and 1.

fem_twist_angle
Sets the maximum acceptable default twist angle between opposing element faces. Applies to 
wedge and brick elements only. Enter a value between 0 and 90.

fem_warp_angle
Sets the maximum acceptable default warp angle value, measured in degrees. Enter a value 
between 0 and 90.

fem_which_ansys_solver Specifies the ANSYS solver to be used. frontal / iterative / powersolver

fem_y_dir_compress
Specifies the Y-direction based on compressed and uncompressed geometry. The default value is 
uncompressed.

yes / no

file_open_default_folder
Sets default dir for File>Open. Working_directory - Search working directory. In_session - Search 
objects in session. Pro_library - Use only if Pro/LIBRARY is installed. Workspace - Use only with 
Pro/INTRALINK. Commonspace - Use only with Pro/INTRALINK.

default / working_directory / 
in_session / pro_library

fix_autocad_iges_text_scale
Fixes scaling problems with AutoCAD releases earlier than Release 10. Yes - Repairs AutoCAD 
files appropriately.

yes / no

fix_boundaries_on_import
Controls fixing of boundaries of imported surfaces. Yes - Fixes boundaries by zipping gaps and 
correcting tangencies. No - Does not fix boundaries.

yes / no

12 of 40 www.ptc.com ©2003, Parametric Technology Corporation ( PTC)



Name Description Values

fix_catia_iges_sym_note
Corrects a problem caused by multiple rotations of a note in a CATIA IGES file. Yes - Rectifies any 
discrepancies.

yes / no

fix_imported_set_view_orient
Sets viewing characteristics for imported CATIA SET files. Yes - Files can have translated views. 
No - Files cannot have translated views.

yes / no

fix_refs_to_intersections
Sets remnant removal ability for the ReIntersect command in the ASSY FEAT menu. Yes - You 
can remove remnants. No - You cannot remove remnants.

yes / no

flip_arrow_scale
Sets a scale factor for enlarging the size of the flip arrow that appears for feature creation direction 
(default = 1).

fonts_size
Determines the relative size of the text in menus and dialog boxes. You must restart 
Pro/ENGINEER for the change to take effect.

small / medium / large

foot_grid_interval Modify grid space in foot units for handle movement.
force_new_file_options_dialog Force the use of the New File Options dialog. yes / no

force_wireframe_in_drawings
Yes - Displays all views of drawings in wireframe. No - Displays views according to the display set 
for the session (wireframe, hidden, and so on).

yes / no

format_setup_file
Assigns a specified setup file to each drawing format. To assign the drawing's parameter values to 
the format, you must retrieve the drawing's setup file into the format.

frames_per_sec Determines whether view is animated. no / yes

frames_per_sec_value
Used to set the smoothness of view animation changes. Higher numbers provide more 
frames/sec, and giving you a smoother animation. Lower numbers cause the view to change more 
quickly.

freeze_failed_assy_comp
No - Requires an action to fix the assembly or freeze the component that fails retrieval. Yes - 
Freezes any component failing retrieval at its last known assembly location. Missing refs using 
offsets or internal datums do not cause components to freeze.

yes / no

full_hlr_for_cables
Full - Removes hidden lines from view when cables hide other geometry (use when Hidden Line 
active). Partial - Cables hide other non-interfering cables except when cables route together 
between same locations. None - Display hidden lines (faster).

none / full / partial

gerber_360_interpolation Yes - Arcs and circles included in outputted Gerber plot files will take this format. no / yes

gpostpp_dir Specifies the directory containing the post processor files to be used by Pro/NCPOST (GPOST).

graphics
Sets the optional graphics environment used by certain platforms for running Pro/ENGINEER. 
Refer to the Installation Guide for a list of defaults and optional graphics.

opengl / x_windows / starbase / xgl 
/ no_graphics

grid_snap
Yes - Makes pick points snap to a grid. No - Turns the grid snap off so that any location can be 
picked.

yes / no

gtol_dim_placement
Controls display of geometric tolerances in Part. Use like drawing set-up option of the same name. 
On_bottom - Gtols display at bottom (below additional lines of text). Under_value - Gtols display 
under dimension value (above additional lines of text).

on_bottom / under_value

harn_tang_line_display Display the tangency lines between cable segments in thick cable display mode. yes / no

help_translation
Specifies the language in which the short help messages display when running non-English 
versions of Pro/ENGINEER. Yes - Display in native language. No - Display in English.

yes / no

highlight_erased_dwg_views
Controls the display of erased view outlines (environment option Highlight Erased Views). Yes - 
Highlights erased views. No - Turns off highlighting for erased views.

yes / no
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highlight_layer_items Specifies whether items selected in the layer tree should be highlighted in the graphics area. yes / no

highlight_new_dims In Drawing mode, highlights new dimensions in red until you move them or repaint the screen. yes / no

hlr_for_quilts
In Drawing, controls quilt display in hidden line removal. Yes - Includes quilts in the hidden line 
removal process (preselects Qlt HLR in the VIEW DISP menu). Default in the VIEW DISP menu, 
uses the value you have set.

yes / no

hole_diameter_override

yes — In the Hole dashboard, you can change the diameter of a suggested default diameter for 
standard tapped and clearance holes. Set this to yes if you are familiar with available drills and 
need to change the system default value. no - Pro/ENGINEER displays a diameter value (based 
on the table lookup function) and grays out the value so you cannot change it. 

yes / no

hole_parameter_file_path Enables you  to use a local hole table instead of the system hole table.

iconify_entire_pro
Determines how many other Pro/ENGINEER windows/menus are iconified when one window is 
iconified. Yes - All the windows and menus are iconified. No - Only the selected window is 
iconified.

no / yes

iges_clip_view_ent
Determines whether IGES entities are clipped with regards to IGES views. YES - Entities outside 
the view outline are clipped. NO - No clipping.

yes / no

iges_clip_view_note
Determines how IGES notes are clipped with regards to IGES views. No_clip - No clipping. 
Full_clip - Notes that are partially outside the view outline are clipped. Partial_clip - Notes 
completely outside the view outline are clipped.

no_clip / full_clip / partial_clip

iges_export_dwg_views Yes - Exports drawing view information. No - Does not export drawing view information. yes / no

iges_in_106_f2_as_spline
No - IGES Copious Data Entity type 106, form 2 is imported as a set of points in 3D space. Yes - 
The entity is imported as a 3D spline.

no / yes

iges_in_assoc_dim_geom_21
Controls if imported IGES associative dimensions remain associative. Yes - If the drawing setup 
option associative_dimensioning is Yes, then the Associativity Instance entity is processed during 
import. No - Dimensions do not retain associativity.

yes / no

iges_in_dwg_color
Yes - Import RGB information to IGES files. The color definition entities in the IGES file are 
imported to the drawings as user-defined colors. No - The color-definition entities in the IGES files 
are ignored when importing to the drawing.

yes / no

iges_in_dwg_line_font
Controls the import of user-defined line fonts. Yes - Give default names to user-defined line styles 
without names in order ("IGES_1," "IGES_2" etc.). No - Imports the user-defined line fonts as Solid 
line font.

yes / no

iges_in_group_to_dwg_layer Yes - Converts an IGES group to drawing layers. No - The IGES group is not converted. no / yes

iges_note_disp
Determines what to do when IGES note entities do not point to any views or the drawing entity. 
See the configuration option iges_zero_view_disp.

as_geometry / all_views / no_views 
/ as_is

iges_out_all_srfs_as
Default - Outputs all surfaces as appropriate IGES surfaces. 114 - This option applies only to 
representations of surface shape. Trimmed surface entities (type 144) are exported regardless of 
setting. 128 - Outputs all surfaces as IGES B-spline surfaces.

128 / 114 / default

iges_out_assembly_default_mode
Set default for assembly export via IGES. Flat - Single level model. One_level - Assy structure with 
pointers to components. All_levels - Assy structure with all comps to IGES files. All_parts - Assy to 
IGES files with geom info of comps and assy feats.

flat / one level / all levels / 
one_level / all_levels / all parts / 
all_parts
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iges_out_catia_gdt_width Yes - Enables the desired width of a gtol symbol to be exported to CATIA. yes / no

iges_out_catia_notes
Yes - Breaks a large note (greater than 70 strings) down into smaller notes, each producing an 
IGES entity.

yes / no

iges_out_dwg_color
Yes - Enables the export of RGB information to IGES files. The user-defined colors in the drawing 
are exported to an IGES file as color definition entities. No - Ignores the user-defined colors in the 
drawing when exporting IGES file.

yes / no

iges_out_dwg_line_font Controls the export of user-defined line font through IGES. No - Exports all geometry as solid font. yes / no

iges_out_ent_as_bspline
True - Exports all geometry entities, other than lines or arcs, as third-degree B-splines. False - 
Does not export entities as third-degree B-splines.

true / false

iges_out_jamais_compliant
Yes - Specifies IGES output with special JAMA-IS subset specification, compliant with the version 
1.02 of JAMA-IS (Japan Automobile Manufacturers Association IGES Subset Specification). No - 
Specifies normal IGES.

yes / no

iges_out_mil_d_28000 Yes - Specifies IGES output that uses the MIL-D-28000 entity subset. yes / no

iges_out_spl_crvs_as_126 Converts all part geometry spline curves to IGES entity 126 (B-spline) when creating an IGES file. no / yes

iges_out_spl_srfs_as_128
Converts all part geometry spline surfaces to IGES entity 128 (B-spline) when creating an IGES 
file.

no / yes

iges_out_start_note
Yes - Exports the text specified by system_iges_header_file and user_iges_header_file as a note 
on the drawing. To control note placement, use the configuration file option 
put_iges_drawing_entity.

yes / no

iges_out_symbol_entity
Exports a drawing symbol as an IGES general symbol entity, IGES type number 228 (yes), or as 
its component entities: notes and lines.

yes / no

iges_out_trim_curve_deviation
Sets the maximum value for the distance between an XYZ trimming curve (boundary) and the 
underlying surface of a trimmed surface

iges_out_trim_xyz Controls whether or not XYZ data is output in addition to UV data for trimmed surfaces. yes / no

iges_out_trm_srfs_as_143 Yes - Exports all surfaces to IGES entities 141 and 143. This overrides option iges_out_trm_xyz. no / yes

iges_zero_view_disp
When IGES geometry does not point to any views or the drawing entity. All_views - Creates a copy 
of the entity for each view. No_views - Does not create the entity at all. As_is - Creates the entity 
once, using only its own transformation information.

all_views / no_views / as_is

ignore_all_ref_scope_settings
Controls whether object-specific reference scope settings are ignored or not. Environment scope 
settings will still be enforced. See also allow_ref_scope_change and default_ext_ref_scope

yes / no

ignore_export_geom_declaration Ignore Export Geometry settings. yes / no
inch_grid_interval Modify grid space in inch units for handle movement.

info_output_format
Setup the default format type for information presentation. Text - information will be output as 
simple text. HTML - information will be output as html data.

text / html / xml_text / dbg_text

info_output_mode
Sets default method for presenting information. Both - View information on screen and write 
information to file. Screen - View information on screen only. File - Write information to file only. 
Choose - Select method from the INFO OUTPUT menu.

choose / screen / file / both
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initial_bend_y_factor
Specifies a constant used to determine the neutral bend line for a sheet metal part. This value is 
always used for non-cylindrical bends. It is used for regular bends only when no bend table is 
specified.

instance_search_exhaustive
Specifies extent of instance search. Yes - Include file type when entering instance name in 
File>Open: type in input panel (e.g. inst_name.prt) or select in drop-down list. If no .idx files are 
found, only working dir is searched; each generic is not.

no / yes

interface_quality
Sets amount of checking for overlapping lines and collecting lines of same pen color before 
exporting plot or 2-D file. 0 - No check or collection. 1 - No check, but collection. 2 - Partial check 
and collection. 3 - Complete check and collection.

intf_cadds_import_make_solid Allows the user to solidify all closed quilts during import CADDS5 model. yes / no

intf_cadds_version
Allows the user to switch between the default and alternate converter version for interface with 
CADDS5

10 / 11 / 12 / 13

intf_in_arclength_reparam
Yes - During import, the system attempts to change parameters for every non-analytical surface 
(Tabulated Cylinders, Surfaces of Revolution, Ruled Surfaces, Spline Surfaces, B-spline 
Surfaces), whose parameters differ significantly from arc-length.

yes / no

intf_in_blanked_entities Filters the import of entities based on their blank status in the import file. yes / no
intf_in_dwg_pnt_ent Yes - Converts an IGES or DXF point entity to a drawing point. yes / no

intf_in_dwg_view
Controls if associativity in an imported IGES view is preserved. 3D_VIEWS - tries to create 3D 
views if 3D model exists in the file. 2D_VIEWS - Imported IGES views work as 2D. No - Imported 
IGES views are exploded and become unrelated.

no / 2d_views / 3d_views

intf_in_extract_profiles Default, no profiles in a data exchange file will be extracted for use. none / comp / all

intf_in_layer_asm_dialog
Yes - Presents a dialog box to control the import of both layers and assemblies. You can choose 
from the list of layers and/or solids available in the file to select one or more for import.

yes / no

intf_in_treat_polyline_as
Enables you to choose the representation of imported independent XYZ polylines. The system 
interprets the imported polylines based on which option is chosen and displays them accordingly.

single_polyline / single_spline / 
set_of_curves / set_of_points

intf_in_use_template_models Allows the user to use template models in Pro/INTERFACE import. yes / no
intf_out_as_bezier Exports all B-splines as Bezier surfaces. yes / no
intf_out_asm_mapped_item Export assembly components and instances using MAPPED ITEM entity. yes / no

intf_out_assign_names
Controls how entity names are handled when an object is exported to STEP format from part or 
assembly mode. You can give unique names to Pro/ENGINEER datum points, datum axes, datum 
curves, surfaces, edges, and quilts.

no_name / user_name / id_name

intf_out_auto_layer_ids
Yes - Automatically assigns interface IDs for layers that were not assigned IDs during export. No - 
Does not assign interface IDs for layers that were not assigned IDs during export.

yes / no

intf_out_blanked_entities Filters export of entities based on their blank status yes / no
intf_out_cat_start_model Specifies Catia start model to be used for CATIA II .model export.
intf_out_layer Layer mapping mechanism providing an ability to group entities to layers or blocks. none / part_layer / block_layer
intf_out_layer_rename_table Enables you to assign interface ids to layers during export
intf_out_max_bspl_degree Controls the maximum degree of exported B-spline surfaces when exporting through IGES
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intf_out_text_length
Sets text length in exported 2-D. As_is - Width of each character is width of strokes. Full_size - 
Width of each character is width of character text box. Adjusted - Adjusts spacing so no extra 
space left and end/start character do not overlap.

as_is / full_size / adjusted

intf_use_variable_size
Yes - IGES,DXF,STEP files with variable sized sheet information are imported andput on the 
appropriate variable-size format. Without a sheet size, the system tries to apply the correct 
variable-size format. No - The IGES,DXF,STEP drawing isplaced on a standar d sized format.

no / yes

intf2d_fit_incompatible_data
YES - For import and export, fixes compatibility problems between 2-D external formats (such as 
IGES and DXF) and Pro/ENGINEER.

yes / no

intf2d_iges_out_hatch
YES - Exports draft xhatching as IGES sectioned area entity. NO - exports draft xhatching as 
separate geometric entities.

yes / no

intf2d_in_iges_hatch_bnd_layer
Yes - Places all sectioned areas boundary imported from the IGES file in one layer named 
IGES_HATCH_BOUNDARY. NO - Does not place sectioned areas boundary in one layer.

yes / no

intf2d_out_cgm_ver Provides the ability to choose CGM metafile version when exporting from Pro/E drawing. 1, 3

intf2d_out_enhanced_ents
Controls whether the enhanced entities (SPLINE and HATCHING) are converted to the 
corresponding DXF entities or represented as separate lines and polylines.

spline_and_hatch / spline_only / 
hatch_only / none

intf2d_out_open_log_window Yes - Opens Export Log File in special window. No - the Log File will not appear in the window. yes / no

intf2d_out_pnt_ent
Yes - Exports a drawing point to IGES, DXF or DWG as a point entity. No - Exports a drawing point 
as shape entities.

yes / no

intf3d_in_close_open_boundaries Controls fixing of open boundaries on imported surfaces. yes / no

intf3d_in_enable_layer_join
No - Join surfaces on import as geometry is loaded from file. Yes - Use new method to join 
surfaces by layer (surfaces contained on the same layer are joined together first) with a better 
chance of joining those surface elements to form closed geometry.

yes / no

intf3d_in_include_items Specifies what entity types you want to import from a file.
srfs_crvs_pnts / srfs_crvs / 
crvs_pnts / srfs_pnts / srfs / crvs / 
pnts

intf3d_out_cat2_ident_crv Specifies model parameter IDENT_CRV while exporting to Catia.
intf3d_out_cat2_ident_pt Specifies model parameter IDENT_PT while exporting to Catia.
intf3d_out_cat2_infinity Specifies model parameter INFINITY while exporting to Catia.
intf3d_out_cat2_model_sz Specifies model parameter MODEL_SZ while exporting to Catia.
intf3d_out_cat2_sag Specifies model parameter SAG while exporting to Catia.
intf3d_out_cat2_step Specifies model parameter STEP while exporting to Catia.
intf3d_out_datums_by_default Determines whether datum curves are included when exporting IGES files in Batch mode. yes / no

intf3d_out_default_option Controls the type of 3-D data output through Pro/BATCH to an IGES or STEP file.
wireframe / surfaces / 
wireframe_surfaces / solid / shells / 
none

intf3d_out_extend_surface Specifies how surfaces are handled for exporting files to other systems yes / no

intf3d_out_force_surf_normals
IGES and PDGS export. Controls normals of non-analytic surfaces. Yes - Forces the surface 
normals to point in a consistent direction. No - Does not force the surface normals to point in a 
consistent direction.

yes / no
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intf3d_out_surface_deviation
Sets maximum allowable deviation between original and resulting surfaces in the process of 
converting Pro/ENGINEER surfaces to spline surfaces. By setting this you convert surfaces with a 
better approximation than by using the current model accuracy.

isogen_attribute_map_file Specifies the mapping between isogen parameter and attribute name.
isogen_endtype_map_file Specify name of file mapping Pro/Piping endtypes with ISOGEN endtypes
isogen_mandatory_attr_file Specify file containing mandatory attribute filenames used by ISOGEN.
isogen_nominal_size_map_file Specify name of file mapping Pro/Piping Size with Nominal Sizes in MM and Inches )
isogen_output_files_dir Specify directory to save the PCFs created by ISOGEN interface
isogen_pcf_filename_format Specify format to create filenames of PCF files being created

isogen_symbol_map_file Specify name of file for mapping Pro/Piping selection names with ISOGEN symbol keys (SKEY)s

jlink_java2 Option to force use of Java-2 JRE command line ("java" instead of "jre") off / on
kbd_cmd_abbreviation On - Enables use of abbreviations when entering menu commands from the keyboard. on / off

kbd_selection
Provides the ability to select locations in the graphics area via the keyboard. Yes - Selection in the 
graphics area may be performed via the keyboard. No - Selection in the graphics area requires a 
mouse.

no / yes

keep_info_datums Sets the initial state of how the system treats datums and features created at run time. yes / no

lang_propagate
Specifies language storage options. The option provides flexibility for objects that use a different 
language than the current

yes / no

let_proe_rename_pdm_objects
Determines whether an object fetched from a PDM database can be renamed in a Pro/Engineer 
session.

no / yes

linear_tol
An alternate format for setting default linear tolerance dimensions. First value sets the number of 
decimal places. Second value is the actual tolerance. For example, 6 0.000025 sets tolerance to 
six decimal places. The default tolerance is 0.000025.

linear_tol_0.0
Specify a range for default tolerances of linear and angular dimensions. These values affect only 
models created after the tolerance options are specified in the configuration file.

linear_tol_0.00
Specify a range for default tolerances of linear and angular dimensions. These values affect only 
models created after the tolerance options are specified in the configuration file.

linear_tol_0.000
Specify a range for default tolerances of linear and angular dimensions. These values affect only 
models created after the tolerance options are specified in the configuration file.

linear_tol_0.0000
Specify a range for default tolerances of linear and angular dimensions. These values affect only 
models created after the tolerance options are specified in the configuration file.

linear_tol_0.00000
Specify a range for default tolerances of linear and angular dimensions. These values affect only 
models created after the tolerance options are specified in the configuration file.

linear_tol_0.000000
Specify a range for default tolerances of linear and angular dimensions. These values affect only 
models created after the tolerance options are specified in the configuration file.

lods_enabled
Determines whether or not the system uses Level of Detail in shaded models during dynamic 
orientation (panning, zooming and spinning).

no / yes

lods_value
When lods_enabled is Yes, this value specifies the default value used to display LODs. The value 
is a percentage of the edge size vs the total size of the model.

maintain_limit_tol_nominal
Maintains the nominal value of a dimension regardless of the changes that you make to the 
tolerance values.

yes / no
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make_parameters_from_fmt_tables
Determines the handling of values entered in a format table when you replace one drawing format 
with another. Yes - Stores entered values for format table and copies them with the table. No - 
Prompts you to re-enter all the values for the format table.

yes / no

make_proj_view_notes
Automatically adds view names to projection views in the format "VIEW viewname-viewname." 
You can modify the view name after adding the view to the drawing.

yes / no

mapkey Stores a keyboard macro. Use Tools>Mapkeys to create, edit and delete mapkeys.

mark_approximate_dims
Yes - Displays a tilde (~) in front of a dimension that is set to display as a fraction and has an 
actual value that is not rounded to equate exactly to the displayed fractional value (the fraction 
shows 7/32 but the actual value is .22, not 0.21875).

yes / no

mass_property_calculate Calculate mass properties upon regeneration or by user request. by_request / automatic

max_animation_time
When the orientation, or zoom state, of the Pro/ENGINEER window changes, an animation 
sequence of a predefined duration takes place. This option controls the maximum time the system 
spends animating.

maximum_texture_size
Allocates a limit to texture size and controls the resizing of texture maps that are used inside 
Pro/ENGINEER graphics only. It has no effect on PhotoRender.

64x64 / 128x128 / 256x256 / 
512x512

mdl_tree_cfg_file Specifies the Model Tree configuration file to be loaded when Pro/ENGINEER is started.
mdo_density Mass density for dynamics.
mdo_explicit_integration Enable explicit integration for dynamic analyses. yes / no
mdo_spring_wire_radius Spring wire radius for dynamics spring icons.

measure_sig_figures
Sets the number of significant figures displayed as results when using the Measure dialog box 
from the Info menu.

medusa_2d_config_file Specifies the Medusa 2D Interface config. file. Absolute or relative path to the file can be used.

mentor_ver_2_0
Yes - Exports the file in IDF 2.0 format. No - Exports the file in IDF 1.0 format unless IDF 2.0 is 
selected from the ECAD FORMAT menu.

yes / no

menu_font
Specify font used in the Pro/ENGINEER menu bar, menus, and all their children. Specify the 
comma-delimited variables in any order (italic bold, 24, times or 24, times, italic bold have the 
same effect). Any omitted variable uses the standard setting.

menu_show_instances Determines whether instance names listed in instance index files appear in file lists. yes / no

menu_translation
Specifies the language in which the menus display when running non-English version of 
Pro/ENGINEER.

yes / no / both

merge_smt_srfs_without_seam
Yes - no edge left at the merge if the sheetmetal surfaces being merged are same surfaces. No - 
edge is left even between same sheetmetal surfaces.

yes / no

mesh_spline_surf Turns the blue mesh surface lines on or off. no / yes
meter_grid_interval Modify grid space in meter units for handle movement.

mfg_auto_ref_prt_as_chk_srf
Yes - In 3, 4, and 5 axis contour and conventional mill sequences, the entire reference part is 
selected as check surfaces by default when computing the NC sequence toolpath for those 
sequences. No - You select the check surfaces.

yes / no

mfg_customize_dialog
Yes - Uses the new customize dialog box for customizing NC sequences. No - Uses the Release 
19.0 menus.

yes / no

mfg_ijk_num_digits Sets the number of digits for i, j, k data points in a CL data file.
mfg_info_location top left /bottom right -Position of the mfg. Info dialog box. top_left / bottom_right
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mfg_modal_command_file
Enables you to make some of the APTn index topics modal, which means that you repeatedly get 
a list of major keywords corresponding to this topic upon completing a command line.

mfg_param_mode
Simple - The parameter tree is shown with a subset of the parameters. Advanced - The parameter 
tree is shown with the entire set of parameters.

simplified / advanced

mfg_template_dir
Specifies the storage directory for NC templates. Specify full path to avoid problems. NC 
templates are used in Expert Machinist. Templates store the recipe for a toolpath as the method of 
tool retrieval.

mfg_workpiece_transparency

The workpiece transparency is controlled by the value of the configuration option 
mfg_workpiece_transparency at the time the workpiece is brought into the manufacturing model 
(assembled or created). You can change its value to a decimal in the range between 0.1 and 1. 
The bigger the value, the more transparent the workpiece. The default value is 0.5

mfg_xyz_num_digits Sets the number of digits for x, y, z data points in a CL data file.
millimeter_grid_interval Modify grid space in millimeter units for handle movement.

min_animation_steps
When the orientation, or zoom state, of the Pro/ENGINEER window changes, an animation 
sequence of predefined duration takes place. This option controls the minimum number of frames 
used in the animation sequence.

minimum_angle_dimension
Controls the minimum angle value under which Pro/ENGINEER assumes colinearity of the 
selected items when creating a driven dimension.

model_allow_ref_scope_change Yes - Users can change the scope setting of components. yes / no
model_grid_balloon_display Controls the display of grid balloons. yes / no

model_grid_neg_prefix Enables you to specify the prefix to use for negative numbers in the balloon capture of the grid.

model_grid_num_dig Controls the number of decimal places displayed in the balloon capture. 0 - Only integers display.

model_grid_spacing Sets the default model grid spacing.

model_note_display
Allows users to display all shown model notes. Applies to shown notes, and does not change 
Show/Erase status of the notes.

yes / no

model_notes_as_labels
Gives the option to display notes as either full text or as label. Can also be toggled with 
environment option "Display Notes as Names."

no / yes

model_rename_template
Sets the default renaming convention for copied assemblies. The default new name is the old 
name appended with an underscore (_). Adding a template such as [*a1*=*b1*] changes every 
occurrence of a1 to b1 (e.g. TOP_A1_BRACKET copies to TOP_B1_BRACKET).

model_tree_start
Toggles display of the Model Tree. Yes - Displays the Model Tree window along with its model. No 
- Does not display the Model Tree window.

no / yes

modelcheck_enabled Enable ModelCHECK yes / no
mold_layout_origin_name Sets a specified coordinate system as the default for the cavity layout origin.
mold_vol_surf_no_auto_rollback Do not perform automatic rollback while modifying mold volumes or parting surfaces. yes / no
motion_envlp_alert Displays the Motion Envelope alert the first time the quality level is increased. yes / no
mp_calc_level Specifies the level of mass properties calculation. assembly_only / all_models
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msg_translation
Specifies language in which Messages are displayed when running non-English version of 
Pro/ENGINEER.

yes / no

multiple_skeletons_allowed Allows/restricts multiple skeleton. yes / no

multipoint_location_count
Specifies the maximum number of cable locations to allow in one feature. To create locations as 
features, set to 1. To limit the number of locations in one feature, set to a number between 2 and 
100.

native_kbd_macros Specifies support of keyboard macros written in native language (for example, German). no / yes

nc_jobman_visible
Yes - make "Submit Path" and "Abort Path" visible. No - make "Submit Path" and "Abort Path" 
invisible.

yes / no

nccheck_type Vericut will be used for NC material removal simulation. vericut / nccheck

ncl_file_extension
Sets the default file extension for Pro/MFG CL data files. Enter the file extension only (without the 
preceding "."). For example, apt produces filename.apt.

ncmdl_bar_stock_part_path
Sets path for storage and retrieval of stock instances for creating workpiece in NC Model. Specify 
full path, including part name, to avoid problems.

ncmdl_billet_stock_part_path
Sets path for storage and retrieval of stock instances for creating workpiece in NC Model. Specify 
full path, including part name, to avoid problems.

ncpost_type Set to GPOST to access the default post processor supplied with Pro/NCPOST. gpost / ncpost

new_asm_regen_revnums

Yes - Regenerate command will not increase the model revision number of the top assembly 
unless features belonging to the top assembly actually get regenerated. Regenerate command will 
increase model revision numbers of subassemblies if features in the subass embly regenerate. No 
- Regenerate command will always increase the revision number of the top assembly and almost 
never increase the revision numbers of subassemblies, regardless of whether or not assembly 
features regenerate.

yes / no

new_designate_ui yes / no
new_parameter_ui Enable the new parameter editor and user interface. yes / no
new_ref_part_name_disabled yes / no
new_relation_ui Enable the new relations editor and user interface. yes / no

number_user_colors
Specifies the maximum number of different wireframe colors that can display in the graphics 
area(s) at any given moment.

number_wireframe_colors
Specifies the maximum number of different wireframe colors that can display in the graphics 
area(s) at any given moment.

offset_line_def_color Specifies the color that offset lines are displayed in drawings.
offset_line_def_font Specifies the font in which offset lines are displayed in drawings.
open_simplified_rep_by_default Name of rep to retrieve upon file open or "Yes" to always invoke open rep dialog.

orientation
Establishes the initial standard view orientation. User_default - System uses X-axis and Y-axis 
values defined by options x_axis and y_axis.

isometric / trimetric / user_default

orthogonal_snap
Controls non-90 degree routing in Pro/DIAGRAM. Yes - Turns the Ortho Snap function on. You 
can sketch wires only at the default horizontal and vertical orientation. No - Enables you to sketch 
wires in drawings at angles other than the default.

yes / no

output_mfg_xml
Allows export/import mfg model to/from xml file. Yes - make Export/Import options visible. No - 
make them invisible.

yes / no
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overlays_enabled
Yes - Enables Pro/ENGINEER screens and menus to be placed on different overlay layers of the 
hardware graphics card. This frees memory for Pro/ENGINEER use.

yes / no

override_store_back Forces the storage of objects retrieved from other directories to the current working directory. yes / no

package_constraints
Action to take for packaged components in Assembly mode. Update - Updates components if 
assembly changes. Freeze - Does not move components if assembly changes. Disallow - Does 
not allow packaged components in assembly (must be fully constrained).

disallow / freeze / update

package_ref_alert
Control whether alert dialog is given when packaged component is referenced. Yes - Allow alert 
when a packaged component is referenced. No - No Alert is given when a packaged component is 
referenced.

yes / no

param_dec_places Sets the number of decimal places (0-14) to display in parameters.

parenthesize_ref_dim
Encloses reference dimensions in parentheses. No - Follows reference dimensions with the text 
"REF".

yes / no

part_table_editor
Sets the editor that is used to edit part and assembly family tables. Protab - Use Pro/TABLE. 
Editor - Use the system editor (refer to pro_editor_command).

protab / editor / excel

pdm_rev
Specify how the system parameter, PDM_REV, should be formatted. Only useful for objects 
submitted to Pro/PDM or Pro/INTRALINK.

pdmrev_fmt_rev_ver / 
pdmrev_fmt_rev / 
pdmrev_fmt_branch_rev_ver / 
pdmrev_fmt_branch_rev

pen_slew
Sets the pen speed for both x and y directions for plotters that are compatible with this option. 
Consult your plotter's user guide for more information.

pen_slew_xy
Sets the pen speed for the x and y directions individually for plotters that are compatible with this 
option. The first value is the x value and the second, the y value. They should be separated by a 
space.

pen_table_file Specifies a default pen mapping table which supersedes other pen mapping information.

pen1_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).

pen2_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).

pen3_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).

pen4_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).

pen5_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).

pen6_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).

pen7_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).

pen8_line_weight
Sets the weight of entities plotted with pens using an electrostatic plotter. The weight is a range 
from 1 (thinnest) to 16 (thickest).
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photorender_capability_warnings Allows the user to disable warnings about PhotoLux only capabilities. yes / no
photorender_default_height Sets the default height (in pixels) for the custom size rendered output
photorender_default_width Sets the default width (in pixels) for the custom size rendered output

photorender_memory_usage
Sets the memory limit that Pro/PHOTORENDER allows for model processing. Do not use commas 
in the memory value, as Pro/ENGINEER interprets these as decimals.

photorender_preview_scale
Allows user defined size ratio at which Pro/PHOTORENDER will render, using the default Render 
To: Full Window Preview setting. Increasing the value creates higher quality rendering with slower 
performance. Reducing the value produces reverse results.

pick_aperture_radius
Specifies the size of the area about the mouse when making selections. Units are 1/1000 of 
screen size.

pick_chain_tangent_only
Specifies the extent of draft entity chains selected. Yes - Only entities in the chain that are tangent 
will be selected. No - All entities connected end to end will be selected.

yes / no

pipe_3d_bend_theor_int_pts Yes - Displays theoretical intersections and bends in three-dimensional models. no / yes

pipe_bend_locations_csys_units
Define which assembly units will be used for the piping bend locations calculations. Yes - to use 
coordinate system assembly units. No - to use pipeline assembly units.

yes / no

pipe_pre_22_bendinfo_conv
Convert bend report information generated prior to Pro/ENGINEER 2000i-2 to current saved 
analysis format.

yes / no

pipe_solid_centerline Yes - Display Pro/PIPING centerlines. No - Do not display Pro/PIPING centerlines. yes / no

pipe_solid_label_format Specify the pipe solid label format that will be used to automatically generate pipeline labels.

pipe_update_pre_20_int_pts
Yes - Pipelines created prior to Release 20.0 are updated with intersection point entities. The 
entities are created in session by Info>Regen Info or when you retrieve the model.

yes / no

pipeline_assembly_library_dir Sets the default pipeline assembly library directory.
pipeline_assembly_name_format Sets the default pipeline assembly name format.
pipeline_label_format Specify the pipeline label format that will be used to automatically generate pipeline labels.
pipeline_solid_start_part_name Sets the default pipeline solid start part name.

pipeline_spool_label_format
Specify the pipeline spool label format that will be used to generate the spool labels during pipeline 
spool generation.

pipeline_start_assembly_name Sets the default pipeline start assembly name.
piping_appearance_map_file Sets the default piping appearance map filename.
piping_bolt_nut_select_file Piping bolts and nuts selection file.

piping_design_method Sets the current Piping design method for pipeline modeling.
non_spec_driven / spec_driven / 
user_driven

piping_end_compatibility_file Sets the default piping end compatibility filename.
piping_fitt_angle_tolerance Sets the default piping fitting angle tolerance value.
piping_fitt_category_map_file Sets the default piping fitting category map filename.
piping_fitt_library_dir Sets the default piping fitting library directory.
piping_fluid_parameter Enables/disables the Parameters tab in Create Pipeline Dialog no / yes
piping_insulation_dir_file Sets the default piping insulation directory filename.
piping_joint_fitting_clearance Sets the piping joint minimum fitting clearance value.
piping_joint_fitting_offset Sets the piping joint minimum fitting offset value.
piping_manufacture_dir_file Sets the default piping manufacture directory filename.
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piping_material_file Sets the default piping material filename.
piping_mcat_dir Sets the default piping master catalog directory.
piping_mcat_dir_file Sets the default piping master catalog directory filename.
piping_min_bolting_clearance Sets the default piping minimum bolting clearance value.
piping_project_data_dir Sets the default Project data directory.
piping_schematic_driven Set the Schematic Driven Pipeline Modeling ON/OFF no / yes
piping_schematic_xml_dir Specify directory with full path containing schematic information XML file(s).
piping_spec_dir_file Sets the default piping specification directory filename.
piping_system_tree_format Sets the default piping model tree format.
piping_thumb_wheel_increment Sets the default piping thumb wheel increment value.
piping_thumb_wheel_ratio_inc Sets the default piping thumb wheel ratio increment value.
piping_wildfire_convert Always ask before converting old piping assemblies to update the network structure. manual / never / automatic

plot_file_dir
Specifies the directory where plot files should be written. Use the full pathname to avoid problems. 
For example /home/users/plotfiles.

plot_linestyle_scale Specifies the scaling factor for the DOTFONT line style in a plot.

plot_names
Yes - Plot files are given descriptive extensions when created. No - All plot files (except PostScript 
plots) are simply given the extension .plt, as before.

yes / no

plot_proceed_dialog
Yes - Enables the Plot Proceed dialog which provides a choice for delaying the printing of plot 
files. This is useful for large plots when using lp print commands. The lp command may not access 
the plot file before it is removed resulting in no output.

yes / no

plot_to_scale_full_window Provides the ability to exclude empty window space when plotting the model to scale. yes / no
plotter Establishes the default plotter for making plot files.

plotter_command
Sets the command that you use to start a plot on your system; for Windows NT or Windows 95, 
windows_print_manager option configures Pro/ENGINEER to plot to a recognized device in the 
Windows NT or Windows 95 print manager.

windows_print_manager /

plotter_handshake Specifies the type of plotter handshake initialization sequence generated in the plotter files. hardware / software

popuphelp_font
Specify font used in the Pro/ENGINEER pop-up help. Add the comma-delimited variables in any 
order (italic bold, 24, times or 24, times, italic bold have the same effect). Any omitted variable 
uses the standard setting.

postscript_compression
Specifies whether or not to compress exported shaded PostScript files. Yes - A shaded postscript 
file created with File>Export will be compressed. This will increase processing time.

yes / no

preferred_save_as_type Allows customizing the order of the Type selections found under File ->Save A Copy.

prehighlight
Yes - Selectable items beneath the pointer are highlighted prior to being selected. No - Selectable 
items beneath the pointer are not highlighted prior to being selected.

none / all / geom_only / yes / no

prev_proc_comp_def_color Specify the default color for components added to a process assembly in a previous step.
prev_proc_comp_def_font Specify the default font for previously added components in a process assembly.
pro_ansys_path Specifies path to ANSYS executable.

pro_catalog_dir
Sets the path to the catalog directory containing the catalog menu and the names of other catalog 
files, such as ejector pins. For example: pro_catalog_dir 
proe_loadpoint/apps_data/mold_data/catalog. Use full path name to avoid problems.

pro_cav_lay_rule_dir Sets the default directory for cavity layout rules. Use the full path name to avoid problems.
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pro_cbltrm_dir Sets the directory from which terminators are retrieved. Use the full pathname to avoid problems.

pro_colormap_path
Specifies the directory path for a color map (.map) file to be loaded from disk. Use the full path 
name to avoid problems.

pro_crosshatch_dir
Specifies a default directory for your cross-hatch library in which you can save cross-hatching 
patterns for later retrieval. Its value is the full path name of the default directory.

pro_dtl_setup_dir
Sets the directory for the drawing setup files. If this option is not set, the system uses the default 
setup directory.

pro_editor_command
Enables use of an editor other than the system editor when the option editor has been specified as 
the value for the options drawing_file_editor and/or family_table_editor and/or relation_file_editor.

pro_font_dir
Sets the default font directory (Pro/ENGINEER will load all fonts in this directory into the drawing 
regardless of the contents of the system and working directories).

pro_format_dir Sets the default directory for the drawing format library. Use the full pathname to avoid problems.

pro_gplug_dir
Specifies the directory in which Granite application plug-ins are located. Use the full pathname to 
avoid problems.

pro_group_dir
Sets the default directory for the user-defined feature (UDF) library. If not specified, your current 
working directory is the default. Use the full pathname to avoid problems.

pro_insulation_dir
Specifies the directory to search for insulation files used in Pro/PIPING. Use full path name to 
avoid problems.

pro_library_dir
Sets the default directory for the Pro/ENGINEER libraries (or any libraries you have built 
containing the proper index menu files). Use the full pathname to avoid problems.

pro_material_dir Sets the default directory for the part material library. Use the full pathname to avoid problems.

pro_mdb_dir
Sets the default directory for the Machinability Database (MDB) files. Use the full pathname to 
avoid problems.

pro_mf_cl_dir
Sets the default directory for the manufacturing CL data files.Use the full pathname to avoid 
problems.

pro_mf_clamp_dir Specifies the directory where the manufacturing clamps can be found.

pro_mf_param_dir
Sets the default directory for the manufacturing parameter files. Use the full pathname to avoid 
problems.

pro_mf_tprm_dir Sets the default directory for the manufacturing tool files. Use the full pathname to avoid problems.

pro_mf_workcell_dir
Sets the default directory for the manufacturing workcell files. Use the full pathname to avoid 
problems.

pro_mfg_cmdsyn_dir
Sets the default directory for the syntax menu files in Pro/MFG. Use the full pathname to avoid 
problems.

pro_nastran_path Specifies the path to the MSC/NASTRAN executable (nastran).

pro_note_dir
Specifies the directory from which to retrieve notes entered from a file. Use the full path name to 
avoid problems.

pro_palette_dir Sets the default directory for drawing symbol palette files.
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pro_pip_fitt_dir Specifies the directory to search for fittings used in Pro/PIPING.

pro_pip_lnstk_dir
Specifies the directory to search for linestock files used in Pro/PIPING. Use full path name to avoid 
problems.

pro_plot_config_dir
Sets the directory of your user-defined plotter configuration file. Use the full pathname to avoid 
problems.

pro_sheet_met_dir
Sets the default directory of your user-defined bend tables. If not set, the Pro/SHEETMETAL 
supplied bend tables are used. Use the full path name to avoid problems.

pro_smt_params_dir
Specifies the directory to save/retrieve Sheet metal parameters files. Use full path name to avoid 
problems.

pro_solver_name
Specifies the name of the user-defined solver to be included in the SOLVE menu. See also 
pro_solver_path.

pro_solver_path
Specifies the path to the user-defined solver whose name is defined in the SOLVE menu. See also 
pro_solver_name

pro_spool_dir Sets the directory from which spools are retrieved. Use the full pathname to avoid problems.
pro_stheno_command Specifies the command for Stheno launch.

pro_surface_finish_dir
Sets the default directory for your user-defined surface finish symbols. Use the full pathname to 
avoid problems.

pro_symbol_dir
Set and automatically create the default directory for saving and retrieving user-defined symbols. If 
you do not specify a directory, the system uses the current working directory. Use full path name to 
avoid problems.

pro_texture_library Allows the user to specify a different graphics library.

pro_unit_length Sets the default units for new objects.
unit_inch / unit_foot / unit_mm / 
unit_cm / unit_m

pro_unit_mass Sets the default units for mass for new objects.
unit_ounce / unit_pound / unit_ton / 
unit_gram / unit_kilogram / 
unit_tonne

pro_unit_sys Specifies the default system of units for new models.
mks / cgs / mmns / fps / ips / 
proe_def

pro_weld_params_dir Specifies the directory to search when a weld parameter file is needed.
prodevdat Specify the name of the Pro/Develop registry file.

profile_output_utils
Affects CL-Data output for profile milling sequences. Yes - Sequence parameter output_point is 
available with options: tip - Toolpath is output with respect to the tool center; on_profile - Toolpath 
is output with respect to the profile of the tool.

yes / no

prompt_on_erase_not_disp
Specifies whether or not to display a prompt allowing you to save your undisplayed objects. This 
option is used in conjunction with the Erase > Not Displayed command on the File menu.

yes / no

prompt_on_exit Determines if you are prompted to save objects when exiting a Pro/ENGINEER session. yes / no
proncpost_dbf Enter directory path to NCPost database file.

propagate_change_to_parents
When saving objects with option save_objects set to Changed or Changed_and_specified, 
Pro/ENGINEER verifies which models are. Yes - Any model that is a parent of a changed model is 
considered to be a changed model when determining what to save.

yes / no
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prorembatch_queue_manager
Enables toolpath computation on a separate host machine. Required values are Processor name, 
Remote machine's hostname, Type of transport (always 0), RPC processor number (same as that 
of remote processor), Version of queue manager.

protable_in_background
Yes - Starts Pro/TABLE editor in the background. Reduces time between pressing a menu button 
that uses Pro/TABLE and entering the data.

no / yes

protkdat Specify the Pro/TOOLKIT registry file.

provide_pick_message_always
No - A message describing the (pre)selected item is provided only while querying. Yes - A 
message describing the selected item is provided in all cases (i.e. even when Query is not used).

yes / no

ps_output_with_pagesize
Specifies whether or not to include pagesize information when generating postscript files from 
Pro/ENGINEER. No - Pro/ENGINEER will omit Adobe level 2 pagesize information from the 
header of the postscript file.

yes / no

ptncpost_dbf Enter directory path to NCPost database file.
punch_axis_points Yes - Enables the creation of punch axis points in Sheetmetal cuts and punches. yes / no

put_iges_drawing_entity
Specifies whether or not to suppress the output of the IGES drawing entity, #404, to the IGES file. 
No - The drawing entity is not output.

yes / no

radial_hole_linear_dim YES - Option for creation of radial hole with a linear dimension will be available. yes / no
raster_plot_dpi Determines the resolution for plotter outputs variables are in dots per inch. 100 / 200 / 300 / 400
ratio_grid_interval Modify grid space in percentage units for handle movement.

read_famtab_file_on_retrieve
No - Ignores filename.ptd. Yes - Creates and saves filename.ptd and uses that file when retrieving 
the generic.

no / yes

read_vda_in_pset_as_spline Specifies whether a VDA Pset entity is imported to Pro/ENGINEER as a spline. yes / no
recompute_iges_dim_value Indicates whether to recompute associative dimensions upon import of an IGES file. yes / no
ref_scope_copy_color Set color of backuped references.
ref_scope_copy_color_change Enable changing colors of backuped references during selection. no / yes
ref_scope_no_pick_to_copy Disable selecting references backuped by references control. no / yes
ref_scope_no_pick_to_prohibit Disable selecting references prohibited by references control. no / yes
ref_scope_prohibit_color Set color of prohibited references.
ref_scope_prohibit_color_change Enable changing colors of prohibited references during selection. no / yes

regen_backup_directory
Specifies the directory in which the system stores regen_backup models. (See 
regen_backup_using_disk.) The primary default is the current directory, but if that directory is read-
only, the secondary default is the /tmp directory.

regen_backup_using_disk Specifies whether or not the system backs up the current model to disk before each regeneration. yes / no

regen_int_mdls_on_retr Yes to regen models intersected with assem feats during assembly retrieval. yes / no

regen_layout_w_assem Specifies whether or not the layout will be automatically regenerated upon assembly regeneration. yes / no

regenerate_read_only_objects
Determines whether an object fetched from a Pro/INTRALINK database with blocking status can 
be regenerated in a Pro/Engineer session.

yes / no

relation_file_editor Sets the editor used to edit relations. protab / editor

remember_last_get_point_option
Yes - Sets the default of the GET POINT menu as the last option picked among Pick Pnt, Vertex 
and On Entity.

yes / no
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rename_drawings_with_object Controls whether the system copies associated drawings automatically with parts and assemblies. none / part / assem / both

replace_comp_name_method Sets the naming convention used when replacing components. transfer / remove / preserve

replace_comp_notes_method
Specify treatment of notes when components are replaced. Transfer - transfer to new component. 
Remove - remove the notes. Preserve - save notes in case component is restored.

transfer / remove / preserve

reserved_menu_space
Reserves space for extra menus to the right of the Pro/ENGINEER window (1.0-4.0). This option 
overrides windows_scale.

restricted_gtol_dialog
Determines whether the Geometric Tolerance dialog restricts the user by graying out elements 
that are considered "illegal".

yes / no

retain_display_memory
Determines if the display of an object currently on the screen is kept in memory when you quit the 
window. Doing so (yes) makes the retrieval of objects in memory faster.

yes / no

retrieve_data_sharing_ref_parts Automatic reference parts retrieval for dependent data sharing features. yes / no
right_mouse_button_popup Specify whether or not the right mouse button pop up menu is available or not. yes / no

rotate_postscript_print
Specifies rotation for printing. Yes - Rotates a PostScript plot 90 degrees counterclockwise. Use 
when you are plotting a landscape drawing on a portrait-type laser printer, or a portrait drawing on 
a landscape-type laser printer.

yes / no

save_bitmap
When performing a save on a model, determines what level of the assembly will have bitmap 
images created of modified components.

none / toplevelonly / alllevels

save_bitmap_type
When performing a save on a model, determines the type of image file that is created for that 
model. Used with "save_bitmap" option.

bmp / tiff / gif / cgm / jpeg

save_display
Yes - Stores view geometry and detail items such as solid dimensions. These items are displayed 
when retrieving the drawing in View-Only mode.

no / yes

save_drawing_picture_file
Embed - Embeds a picture file inside a drawing for preview purposes. Export - Saves a drawing 
file as a picture file in the working directory when saving a drawing. Both - Does both embed and 
export.

no / export / embed / both

save_instance_accelerator
With family tables of solid parts, determines how instances are saved. None - Instance accelerator 
files not used. Explicit - Save instance accelerator files when instances explicitly saved. Always - 
Always save instance accelerator files.

none / explicit / always

save_model_display
Sets amount of graphical data stored. Wireframe - Wireframe data. Shading_high - Most detail 
(shaded). Shading_med - Medium detail (shaded). Shading_low - Least detail (shaded). 
Shading_lod - Detail determined by View Performance dialog (shaded).

no_display / wireframe / 
shading_low / shading_high / 
shading_lod

save_modified_draw_models_only
Determines whether the system saves the model after you have changed it. No - Saves the model 
every time that you store the drawing.

no / yes

save_object_in_current
Use with the override_store_back option. Yes - Objects retrieved from a directory where you do 
not have write permission will be stored in the current directory. No - These objects are not saved 
at all.

yes / no

save_objects
Determines when an object and its dependent objects (such as a part used in an assembly) are 
stored.

all / changed / 
changed_and_specified / 
changed_and_updated

save_triangles_flag
Spinning shaded images with software graphics only. Note: This option has no effect if your 
system uses hardware graphics.

no / yes

28 of 40 www.ptc.com ©2003, Parametric Technology Corporation ( PTC)



Name Description Values

save_unchanged_pdm_object
Determines how to save in the current working directory an object fetched from a Pro/PDM 
database into a Pro/ENGINEER session.

as_ref / as_copy

scope_invalid_refs
Prohibit - System will abort all attempts to create external reference violating the scope. Backup - 
Warning appears. Abort reference creation or declare as out-of-scope reference. If you declare, 
backup copies to part/assembly and backup is referenced.

copy / prohibit

search_path
Specifies list of directories to search (in order) for object/file retrieval. These directories, the 
working directory, and directories in search.pro file (refer to search_path_file) are 
Pro/ENGINEER's search path. Use full path name to avoid problems.

search_path_file
Specifies path to text file search.pro (a list of directory path names). The directories listed in 
search.pro, the working directory, and directories specified by search_path are Pro/ENGINEER's 
search path. Use full path name to avoid problems.

section_color Specifies the color of sketched sections. default / drawing_color

sel_insts_on_comp_retrieval
Yes - If the components used in the assembly instances are themselves generics, the systems 
asks if you want to choose an instance as each component is retrieved. No - The generic model of 
the component is retrieved automatically.

yes / no

select_hidden_edges_in_dwg Controls selectability of hidden edges in no-hidden drawing views. yes / no

select_on_dtm_edges
All_modes - Select a datum plane by clicking on its visual boundary. Sketcher_only - Select a 
datum plane by clicking on its tag in modes other than Sketcher. If you use Query frequently, set 
this option to Sketcher_only.

all_modes / sketcher_only

selection_of_removed_entities
Yes - Entities in front of cross-section (planar or offset) can be selected, clipped (using Z-clipping), 
or erased with EDGE DISP menu. No - Geometry, datum points or curves, cosmetic features, 
threads, grooves, or coordinate systems cannot be erased.

yes / no

set_menu_width
Determines width of menu manager panels. Default value is equivalent to 8 character widths. 
Acceptable range is from 8 to 20. Values lower than 8 and higher than 20 are ignored.

set_model_types_to_save
Determines which model types are used in the Save Changed command. The format is a list of 
extensions separated by spaces.

set_trail_single_step Yes - Enables a trail file to be single-stepped by entering . yes / no

shade_mfg_ref_models
No - Does not process reference parts when generating the shaded image (to save time). Yes - 
Shades reference parts when generating shaded images.

no / yes

shade_moving_comp
Yes - Shades assembly components while they are being moved. No - Displays components in 
wireframe while they are being moved.

yes / no

shade_surface_feat Controls the shading of surface features. yes / no
shade_windows Enables shading of objects in all windows. This option does not also enable color shading. all_windows / one_window
shade_with Controls the display of datum curves on shaded objects. curves / no
shaded_postscript_background Specifies how background colors are handled in Postscript files of shaded objects. yes / no
show_all_mold_layout_buttons Sets all mold layout buttons visible. yes / no
show_axes_for_extr_arcs Determines if axes are created for newly extruded arcs. yes / no
show_cav_fit_loc_sys Allows the printing of the transformation matrix of a Pro/Verify Fit into a file. yes / no

show_dim_sign
No - Dimension values always appear positive. Negative value creates geometry to opposite side. 
Yes - Entering negative value for dim displayed as negative creates geometry to same side. Dims 
for csys and datum point offsets always show neg/pos value.

yes / no
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show_geom_checks_on_creation
Yes - The SHOW ERRORS menu appears at the end of feature creation when the feature being 
created has Geometry Checks.

yes / no

show_preview_default This option determines the default behavior for preview in Show/Erase. keep / remove

show_shaded_edges
Controls the edge color when shading. Yes - Edges are displayed in darker color than the surfaces 
to which they belong. No - Edges are displayed in the same color as the surfaces to which they 
belong.

no / yes

shrinkage_value_display
Determines how dimensions are displayed when shrinkage is applied to a model with 
Pro/MOLDESIGN. Percent_shrink - Dimensions appear with the shrinkage percent.

final_value / percent_shrink

shrinkwrap_alert Displays the Shrinkwrap alert the first time the quality level is increased. yes / no
silhouettes Specifies whether silhouette edges are displayed or not by default. no / yes

sim_asm_modeling
Controls automatic creation of assembly links and free connections in Pro/MECHANICA. The 
default is YES.

yes / no

sim_display_arrow_scale Toggles automatic arrow scaling. yes / no
sim_display_arrow_tail_touching Toggles display of Load arrows to have tails or heads touching. yes / no
sim_display_beam_releases Toggles display of Beam Release icons. yes / no
sim_display_beam_sections Toggles display of beam section icons. yes / no
sim_display_beams Toggles display of beam icons. no / yes
sim_display_condensation_intfs Toggles display of condensation interfaces icons. yes / no
sim_display_contact_regions Toggles display of Contact Region icons. yes / no
sim_display_gaps Toggles display of gap icons. no / yes
sim_display_in_spin Toggles display of simulation objects in Dynamic Spin. yes / no
sim_display_interfaces Toggles display of structure connection icons. no / yes
sim_display_load_colors Toggles display of Load colors. yes / no
sim_display_load_distribution Toggles display of distributed load vectors over entire entity. yes / no
sim_display_load_icons Toggles display of load icons. yes / no
sim_display_load_value Toggles display of Load values. yes / no
sim_display_masses Toggles display of mass icons. no / yes
sim_display_matl_assignments Toggles display of Material Assignment icons. yes / no
sim_display_mesh_and_model Toggles display of Mesh together with Model. yes / no
sim_display_mesh_entities Toggles display of Mesh entities. yes / no

sim_display_mesh_mode Specifies the mode of mesh display in FEM preprocessor.
no_mesh / wireframe / hidden / 
nohidden / shading

sim_display_mesh_shrink_elems Controls display of Mesh through a specified percentage of shrinking of its elements.
sim_display_motion_cams Toggles display of motion cam icons. yes / no
sim_display_motion_connections Toggles display of motion connection icons. yes / no
sim_display_motion_contact_rgns Toggles display of motion contact region icons. yes / no
sim_display_motion_design_vars Toggles display of design variable icons. yes / no
sim_display_motion_drivers Toggles display of motion driver icons. yes / no
sim_display_motion_gears Toggles display of motion gear icons. yes / no
sim_display_motion_ground_pnts Toggles display of motion ground point icons. yes / no
sim_display_motion_lcs Toggles display of local coordinate systems icons. yes / no
sim_display_motion_loads Toggles display of motion load icons. yes / no
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sim_display_motion_slots Toggles display of motion slot icons. yes / no
sim_display_names Toggles display of Simulation Object names. yes / no
sim_display_rigid_connections Toggles display of rigid connection icons. yes / no
sim_display_rigid_dof Toggles display of Rigid Link DOF icons. yes / no
sim_display_rigid_links Toggles display of Rigid Link icons. yes / no
sim_display_shells Toggles display of shell icons. no / yes
sim_display_spot_welds Toggles display of spot weld icons. yes / no
sim_display_springs Toggles display of spring icons. no / yes
sim_display_struct_constraints Toggles display of structure constraint icons. yes / no
sim_display_struct_loads Toggles display of structure load icons. yes / no
sim_display_therm_bcs Toggles display of Thermal Boundary Condition icons. yes / no
sim_display_therm_loads Toggles display of thermal load icons. yes / no
sim_display_weighted_dof Toggles display of Weighted Link DOF icons. yes / no
sim_display_weighted_links Toggles display of Weighted Link icons. yes / no
sim_display_welds Toggles display of Weld icons. yes / no
sim_fatigue_biaxiality_correct Controls the use of biaxiality correction. The default value is YES. yes / no

sim_fatigue_biaxiality_method
Controls which method is used to model biaxiality: Klann-Tipton-Cordes, Hoffman-Seeger, or the 
most conservative (worst) of the two methods. The default value is WORST.

worst / ktc / hs

sim_fatigue_confidence_level
Specifies the percentage confidence in the predicted life result value. The default value is 90, and 
range is from 0.1 to 99.9

sim_fatigue_external_matdata Controls the use of external material data. The default value is NO. no / yes

sim_fatigue_hysteresis_gate
Specifies the gate applied to cycle counting as a percentage of peak load. The default value is 1 
and range is from 0 to 50.

sim_fatigue_infinite_life_value
Specifies the value for the lives beyond cutoff. The default value is 1e20 and range is from 1e15 to 
1e30.

sim_fatigue_mean_stress Controls the application of the mean stress correction. The default value is YES. yes / no

sim_fatigue_mean_stress_method
Controls which method is used to model mean stress: the Smith-Watson-Topper Approach, 
Morrow Correction, or the most conservative (worst) of the two methods. The default value is 
WORST.

worst / swt / morrow

sim_fatigue_safety_margin
Specifies a factor used to determine the Life Confidence quantity. The default value is 3 and range 
is from 1.1 to 100.

sim_fatigue_user_directory
Specifies the directory for user files (for example, external material files). The default value is the 
current directory.

sim_fatigue_write_surf_stress Controls writing of surface stresses to a neutral file. The default value is NO. no / yes

sim_fem_nastran_use_pshell
Yes - use PSHELL cards, No - use PCOMP cards for laminate composite shells in NASTRAN 
output file.

yes / no

sim_load_mech_mesh
No - The user is prompted to load the existing Mechanica mesh file from the current working 
directory. Yes - The mesh file, if exists, is loaded automatically and the mesh is displayed.

no / yes

sim_mat_poissons_notation
Specifies the convention used for defining Poisson's ratio for anisotropic materials as being either 
Tsai (Column-normalized) or Jones (Row-normalized). This option affects only the labels for 
Poisson's ratio on the Material data form.

tsai / jones
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sim_max_memory_usage
Specifies the amount of memory in megabytes to be used in Mechanica run and FEM mesher. The 
default value is 128.

sim_motion_analysis_accuracy
Specifies the default accuracy to which Pro/MECHANICA determines values at each increment of 
the analysis. This number represents the acceptable fractional error in the computation of joint 
axis positions and rates at each time increment of the analysis. The default value is 0.0001.

sim_motion_analysis_assem_tol Specifies the default error allowed for the assembly analysis. The default value is 0.001.

sim_motion_analysis_duration
Specifies the default length of time in seconds during which the analysis runs. The analysis 
duration can be less than the duration of the motion simulation. The default value is 10.0.

sim_motion_analysis_increment
Specifies the default increment between steps at which Pro/MECHANICA reports the motion of the 
mechanism. The default value is 0.1

sim_motion_analysis_integrator
Controls the default integrator Pro/MECHANICA uses when running the motion analysis. The 
value types are IMPLICIT (default) and EXPLICIT.

implicit / explicit

sim_motion_analysis_method
Controls the default method Pro/MECHANICA uses to analyze the motion of your model. The 
default is FASTEST_AVAILABLE.

fastest_available / time_integration 
/ kinetostatic

sim_motion_analysis_start_time Specifies the default time in seconds at which the motion analysis begins. The default value is 0.

sim_motion_analysis_vel_tol Specifies the default error allowed for the velocity analysis. The default value is 0.001.

sim_motion_output_fly_file
Controls the creation of .fra file when saving results for a motion model, The .fra file is used to 
import a motion animation into Pro/FLY-THROUGH. The default is NO.

no / yes

sim_nastran_use_coupmass Add PARAM,COUPMASS,1 in the Nastran deck file to enforce consistent mass matrix generation. yes / no

sim_output_ids_for_layers Outputs FEM mesh element IDs on each layer into XML file. yes / no

sim_output_obj_names Output Beam Sections names, Analyses names, Coordinate Systems names as comments. yes / no

sim_pp_background_color Specifies the background color of the work area for the results display. The default value is PROE. proe / blue / black / white

sim_pp_vrml_export_format Flags to denote VRML1.0 or VRML2.0 (default) output. vrml2.0 / vrml1.0
sim_pp_vrml_feature_edges Flag to enable the inclusion of feature edges in the VRML file. The default value is NO. no / yes

sim_regen_on_entry Yes - Regenerate model on entrance to Simulation Application. No - Don't regenerate the model. yes / no

sim_run_copy_fem_neutral_file
Controls whether the FEM neutral file (with extension .fnf) is copied into the study directory. The 
default value is YES.

yes / no

sim_run_out_dir
Specifies the directory for Pro/MECHANICA run temporary storage. By default, the current 
directory is used.

sim_run_tmp_dir
Specifies the directory for Pro/MECHANICA run output storage. By default, the current directory is 
used.

sim_use_layers Allows layers to become groups for Pro/MECHANICA Independent mode. no / yes
simulation_fem_mode Yes - Activates FEM mode. No - Allows access to Mechanica only. yes / no

skeleton_model_default_color
Specifies the color Pro/ENGINEER uses to display new skeleton models. The three decimal 
values ranging from 0 through 100 specify (in order) the percentages of red, green, and blue in the 
resulting color. For example, 0 0 49 specifies medium blue.
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sketcher_animated_modify No - The section is not animated as modifications are regenerated. yes / no

sketcher_blended_background
This option controls whether the blended background should be used in 3D Sketcher. The option 
has no effect if blended background is turned off generally.

no / yes

sketcher_collinear_skamps
Yes - collinear constraints will be used by Intent Manager; No - collinear constraints will not be 
used by Intent Manager.

no / yes

sketcher_dec_places
Sets the default number of decimal places displayed for dimensions in Sketcher. The extrusion 
depth or any other dimension you enter to create 3D geometry is controlled by the 
default_dec_places option.

sketcher_disp_constraints
Shows the constraints when sketching in Sketcher Mode; for example, H for horizontal, V for 
vertical, and so on.

yes / no

sketcher_disp_dimensions No - Suppresses the display of all dimensions while in sketcher. yes / no
sketcher_disp_grid Specify whether or not to display the sketcher grid. yes / no
sketcher_disp_vertices No - Suppresses the display of yellow points on all vertices while in sketcher. yes / no
sketcher_disp_weak_dimensions Yes - weak dimensions will be displayed; No - weak dimensions will not be displayed. yes / no

sketcher_equal_length_skamps
Yes - equal length constraints will be used by Intent Manager; No - equal length constraints will not 
be used by Intent Manager.

no / yes

sketcher_equal_radii_skamps
Yes - equal radii constraints will be used by Intent Manager; No - equal radii constraints will not be 
used by Intent Manager.

no / yes

sketcher_grid_angle Enter a grid angle value to overide the default grid angle value.

sketcher_intent_manager
Specifies which sketcher to use. Yes - Intent Manager is the default. No - Old sketcher is the 
default.

yes / no

sketcher_lineup_hor_skamps
Yes - line up horizontal constraints will be used by Intent Manager; No - line up horizontal 
constraints will not be used by Intent Manager.

no / yes

sketcher_lineup_ver_skamps
Yes - line up vertical constraints will be used by Intent Manager; No - line up vertical constraints 
will not be used by Intent Manager.

no / yes

sketcher_lock_modified_dims Yes - modified dimensions will be locked; No - modified dimensions will not be locked. yes / no

sketcher_midpoint_skamps
Yes - midpoint constraints will be used by Intent Manager; No - midpoint constraints will not be 
used by Intent Manager. )

no / yes

sketcher_num_digits Enter a number of digits for scetcher accuracy.

sketcher_parallel_skamps
Yes - parallel constraints will be used by Intent Manager; No - parallel constraints will not be used 
by Intent Manager.

no / yes

sketcher_perpendicular_skamps
Yes - perpendicular constraints will be used by Intent Manager; No - perpendicular constraints will 
not be used by Intent Manager.

no / yes

sketcher_point_on_entry_skamps
Yes - point on entry constraints will be used by Intent Manager; No - point on entry constraints will 
not be used by Intent Manager.

no / yes

sketcher_refit_after_dim_modify Refits section after dimension modification in 2D section or when creating the first feature. yes / no
sketcher_rel_accuracy Enter a sketcher relative accuracy.

sketcher_same_point_skamps
Yes - same points constraints will be used by Intent Manager; No - same points constraints will not 
be used by Intent Manager.

no / yes

sketcher_save_preview_image
This option controls whether section files should be saved with embedded image information 
which can be used to preview sections in File/Open dialog.

no / yes
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sketcher_set_grid_method "Automatic" - grid spacing will be automatically set, "Manual" - grid spacing will be manually set. automatic / manual

sketcher_set_grid_x_spacing Enter a x-grid spacing value to overide the default x-grid spacing value.
sketcher_set_grid_y_spacing Enter a y-grid spacing value to overide the default y-grid spacing value.

sketcher_starts_in_2d
Defines initial model orientation in Sketcher mode. Yes - (2D orientation) Looking directly at 
section (sketching) plane. No - (Orientation unchanged) Sketch directly on the 3D part.

yes / no

sketcher_symmetric_skamps
Yes - symmetric constraints will be used by Intent Manager; No - symmetric constraints will not be 
used by Intent Manager.

no / yes

sketcher_tangent_skamps
Yes - tangent constraints will be used by Intent Manager; No - tangent constraints will not be used 
by Intent Manager.

no / yes

sketcher_undo_stack_limit
Sketcher saves a copy of each function performed. The number of possible saved functions 
depend on the number specified in the option. The undo menu can be used to remove the stored 
functions.

smooth_lines Choose whether to smooth lines by default or not. no / yes
smt_bend_notes_dflt_display Define the default state of Bend Note display (sheetmetal Mode) yes / no
smt_bend_notes_direction_down Define the Down Direction symbol for Bend Notes (sheetmetal Mode)
smt_bend_notes_direction_up Define the Up Direction symbol for Bend Notes (sheetmetal Mode)
smt_bend_notes_order Define the Fields Order for Bend Notes (sheetmetal Mode)
smt_bend_notes_type_formed Define the Formed symbol for Bend Notes (sheetmetal Mode)
smt_bend_notes_type_rolled Define the Rolled symbol for Bend Notes (sheetmetal Mode)
smt_crn_rel_display Yes - Corner relief notes will be displayed. No - Corner relief notes will not be displayed. no / yes

smt_mp_method
MASS - Suppressed Flat Pattern and Flatten Forms will be temporary resumed before mass 
properties calculation of sheetmetal part. CG - Mass Properties calculation will be performed on 
current state of sheetmetal part. BOTH - Both methods will be used one afte r the other.

mass / cg / both

smt_outside_mold_lines Yes - Outside Mold Lines will be created during Flat Pattern creation. yes / no
spin_center_display Determines whether or not the spin center symbol displays. yes / no

spin_control
Specifies spin mode of an object. Click - Pick a place on the scale to reorient model to this 
position. Drag - Pick on current value and drag it along scale to change model orientation 
continuously. To stabilize orientation angle, pick on scale again.

drag / click

spin_rate_zoom_sensitive Allows slower spinning when zoomed in on a model. yes / no
spin_with_notes Yes - 3D feature and model notes are displayed during dynamic spinning of a model. yes / no
spin_with_part_entities Yes - Datum features will be displayed during dynamic spinning of a model. yes / no
spin_with_silhouettes Yes - Silhouette lines will be displayed during dynamic spinning of a model. no / yes
start_appmgr Determines whether or not the application manager starts when Pro/ENGINEER is started. yes / no
start_model_dir Provides the complete path to the directory containing start parts and assemblies.
std_nastran_template Sets the file path of a NASTRAN deck template. Use full path to avoid problems.

step_appearance_layers_groups
No - Output of Appearances, Layers, and Groups is enabled for STEP standard AP214. Yes - 
Output of Appearances, Layers, and Groups is enabled for STEP standard AP203.

yes / no

step_export_ap214_asm_def_mode
Toggles the default setting of the File Structure field in the STEP Export dialog box for supported 
assembly STEP export files.

single_file / separate_parts_only / 
separate_all_objects
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step_export_dwg_views
AS_3D_VIEWS - Export 3-D model geometry with its associative views. 
AS_3D_VIEWS_ASSOC_DRAFT - Export 3-D model geometry with its associative views and view 
related annotations. NO - Export only 2-D representations of the 3-D models. This is the default.

no / as_3d_views / 
as_3d_views_assoc_draft

step_export_format
Specifies output format when exporting to STEP. AP203_IS - Formats output to ISO 10303 
AP203IS format. AP214_CD - Formats output with geometry that meets the specification for the 
long-term schema for AP214cc1.

ap203_is / ap203_dis / ap214_cd / 
ap202_is / 203_is_ext / ap214_dis / 
ap209_dis

store_tool_path_file
Specifies how tool path information is computed. Yes - Tool path information stored in file 
filename.tph (filename is manufacturing model name). No - Tool path is computed each time 
manufacturing model is retrieved or parameters are changed.

yes / no

style_default_connections Yes - Add connections to a newly created Style surface. yes / no
summary_help Refers to the one-line help Messages that are either displayed or not displayed. yes / no
suppress_dlg_license_expired Suppresses "License expired: List of options and expiration days" dialog

suppress_license_loss_dialog
Yes - Suppresses the 'Regained Floating License' dialog box. No - The 'Regained Floating 
License' dialog box will display.

yes / no

switch_dims_for_notes
Yes - Dimensions will be displayed in their symbolic format during drawing note creation. No - 
Dimensions will be displayed in drawing notes as numerical values.

yes / no

sym_leader_orient_move_text With Pro/DETAIL, automatically regroups weld symbol instances after you move the text. yes / no
symbol_instance_palette_file Specifies the location of the symbol instance palette.
symbol_palette_input Controls the display of the special symbol palette during note creation. yes / no

system_background_color
Defines default graphics area background color. The three decimal values specify (in order) 
percentage of red, green and blue in the resulting color. For example, 0 0 49 specifies a medium 
blue. Change in session using View>Display Settings>System Colors.

system_colors_file Specifies the system color file. Use the full path name to avoid problems.

system_curves_color
Defines default curve color. The three decimal values specify (in order) percentage of red, green 
and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors.

system_dimmed_menu_color
Defines default secondary highlight color. The three decimal values specify (in order) percentage 
of red, green and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change 
in session using View>Display Settings>System Colors.

system_edge_high_color
Defines default edge highlight color. The three decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change in 
session using View>Display Settings>System Colors.

system_geometry_color
Defines default color of solid wireframe entities. The three decimal values specify (in order) 
percentage of red, green and blue in the resulting color. For example, 0 0 49 specifies a medium 
blue. Change in session using View>Display Settings>System Colors.

system_hidden_color
Defines default color of hidden, wireframe entities. The three decimal values specify (in order) 
percentage of red, green and blue in the resulting color. For example, 0 0 49 specifies a medium 
blue. Change in session using View>Display Settings>System Colors.
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system_highlight_color
Defines default primary highlight color. The three decimal values specify (in order) percentage of 
red, green and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change in 
session using View>Display Settings>System Colors.

system_iges_header_file
Inserts specified text file into the Start section of IGES files (refer to user_iges_header_file). When 
used with user_iges_header_file, the system text appears first.

system_letter_color
Defines default color of datum tags. The three decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change in 
session using View>Display Settings>System Colors.

system_section_color
Defines default section color. The three decimal values specify (in order) percentage of red, green 
and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors.

system_sheetmetal_color
Defines default color of Sheetmetal parts. The three decimal values specify (in order) percentage 
of red, green and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change 
in session using View>Display Settings>System Colors.

system_volume_color
Defines default color of Manufacturing volumes. The three decimal values specify (in order) 
percentage of red, green and blue in the resulting color. For example, 0 0 49 specifies a medium 
blue. Change in session using View>Display Settings>System Colors.

tablet_device_name Specifies the name of a digitizing tablet.

tan_angle_for_disp
For display purposes only. Sets the angle between two quilt surfaces below which the edge will be 
displayed as tangent. Enter an angle between 1.5 and 15 degrees.

tangent_edge_display Determines how edges between tangent surfaces are displayed.
no / solid / centerline / phantom / 
dimmed

template_designasm Specifies the designated template assembly. Use full path to avoid problems.
template_drawing Specify the drawing used as the default drawing template.
template_ecadasm Specify the model used as the default ECAD assembly template.
template_ecadpart Specify the model used as the default ECAD part template.
template_mfgcast Specify the model used as the default manufacturing cast template.
template_mfgmold Specify the model used as the default manufacturing mold template.
template_mold_layout Specify the mold layout assembly used as a default template.
template_sheetmetalpart Specify the model used as the default sheetmetal part template.
template_solidpart Specify the model used as the default part template.

terminal_command
Specifies the full path to the terminal emulator command (the command that starts shell windows). 
Use the command for your system. Enter the complete path name and the terminal command.

texture Yes - Applied textures will be displayed when the model is shaded. no / yes
texture_search_path Appends a directory to the search path for textures.

thermo_position_hint
Enables you to position the thermometer-type scales whenever they appear, so that they do not 
overlap the Pro/ENGINEER windows (if space permits, for example, if windows have been 
scaled).

no_window_overlap / 
window_overlap

tiff_compression Determines whether or not to-tiff exports are compressed using G4 compression none / g4
tiff_type Determines the type of tiff items are exported to variables refer to color sets rgb / palette / grayscale / mono
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todays_date_note_format
Controls the initial format of the date displayed in a drawing. The format for the setting is a string 
consisting of three portions: the year, the month, and the date. You can enter the portions in any 
order.

tol_display Displays dimensions with or without tolerances. yes / no

tol_mode
Nominal - Displays dimensions without tolerances. Limits - Displays upper and lower limits. 
Plusminus - Displays as nominal with plus-minus tolerances. Plusminussym - Displays as nominal 
with single value for positive and negative tolerance.

nominal / limits / plusminus / 
plusminussym

tolerance_class
Sets the default tolerance class for ISO-standard models. The system uses the tolerance class in 
conjunction with the dimension value when retrieving tolerances for General or Broken Edge 
dimensions.

fine / medium / coarse / 
very_coarse

tolerance_standard Sets the tolerance standard used when creating the model. ansi / iso

tolerance_table_dir
Sets the default directory for user-defined tolerance tables for ISO-standard models. All Holes and 
Shafts tables overwrite existing tables when loaded.

toolkit_registry_file
Tells Pro/E the full path to which toolkit registry file to be used. This option replaces the R17 option 
prodevdat.

topobus_enable Enables usage of the Associative Topology Bus for exchanging data. yes / no
tracesketch no / yes
trail_delay Sets a delay in seconds between trail file steps.

trail_dir
Instructs Pro/ENGINEER to create its trail file in the specified directory rather than in the startup 
directory.

train_file_path
Specifies the default directory for training files. The path name must start from the root of the 
directory, for example, /home/users/library/training.

transparency Yes - Transparent colors will appear as such when the model is shaded. no / yes
units_system_dic_file Specifies the file containing the mapping for MCAT filename and units.
update_harness_mfg_line_color Update cable line color for harness-mfg part created in release 2000i or earlier. yes / no

update_pre_130_harness
Yes - When a cable is added between two previously laid out locations in a three-dimensional 
reference harness, display of the new cable will update automatically in pre-Release 13 flattened 
cable models.

yes / no

update_pre_16_cable_layers
Yes - Harnesses containing cables routed prior to Release 16.0 will be automatically updated upon 
retrieval to comply with new display standards.

yes / no

update_rep_refs
"Yes" updates top assembly simplified reps for replacements during regeneration and upon 
replacement.

yes / no

use_8_plotter_pens Specifies whether to support up to 8 plotter pens. The initial default is 4 pens. no / yes

use_cadam_plot_data
Determines whether the information in the Plot Axis System element should be taken into account 
when importing a CADAM drawing.

yes / no

use_export_2d_dialog
Yes - Opens export options dialog when exporting Pro/E drawing. No - exports file without the 
options dialog.

yes / no

use_iges_font_1003 Used to disable the use of IGES font 1003. yes / no

use_iges_kanji_font_2001
Specifies whether to convert Kanji notes in Pro/ENGINEER to IGES Kanji notes (font code) when 
exporting. Yes - Converts Kanji notes to IGES Kanji notes. No - Converts using Font 1.

yes / no

37 of 40 www.ptc.com ©2003, Parametric Technology Corporation ( PTC)



Name Description Values

use_major_units
Determines if fractional dimensions are displayed in terms of feet-inches or meter-mm. Yes - The 
major units are used. For example, when the units are inches and 25.125 is converted to a 
fraction, the dimension becomes 2' 1-1/8".

yes / no

use_master_for_bad_disp_reps Yes to retrieve master rep when graphics rep has no display data. yes / no
use_master_for_bad_disp_reps Yes to retrieve master rep when graphics rep has no display data. yes / no

use_new_intchg
"yes"-Pro/ENGINEER uses the consolidated interchange assembly functionality. "no"-
Pro/ENGINEER uses the separate functional interchange assemblies and simplify interchange 
assemblies.

yes / no

use_nom_dim_val_in_expr Yes - use dimensions' nominal values in expressions. No - use current values. yes / no

use_part_color_for_hidden_lines
Determines how to color the hidden lines of parts that have user defined colors. "YES" - Use the 
dimmed part color for hidden lines. SYSTEM_HIDDEN_COLOR is ignored if it has been specified.

no / yes

use_pre_wildfire_text_font
Yes - Use the old stroke-based PTC font as the default font. No - Use a True Type font as the 
default font.

no / yes

use_software_linefonts
Yes - The exact line style used in Pro/ENGINEER is plotted, stroked out dot by dot, dash by dash, 
and space by space. No - plots lines using the line font it supports which most closely resembles 
the font used in Pro/ENGINEER.

yes / no

use_temp_dir_for_inst Explicitly makes Pro/ENGINEER use the Temp directory for regenerating instances of models. no / yes

user_defined_grid_interval Modify grid space in user defined length units for handle movement.

user_iges_header_file
Filename - Insert specified text file into the Start section of IGES file. Valid parametric note 
symbols will be replaced during export. For example, \&dwg_name in the text file is replaced by 
the drawing name when a drawing is exported.

variable_plots_in_inches No - Variable plot sizes may be entered in millimeters. yes / no

variant_drawing_item_sizes
No - Drawing items moved/copied to a different sheet or located on a changed sheet keep same 
size and relative orientation on paper. Yes - Some items scale/reposition to be the same on paper, 
and others scale and/or reposition to be the same on screen.

yes / no

vda_header
The complete filename of the text file containing VDA header information. If you intend to use the 
same header for all VDA files, specify the full pathname.

versatec_cutter_installed Yes - Indicates that a cutter is installed on a Versatec plotter. no / yes

visible_mapkeys
No - Mapkeys will run without displaying picks being made in the Menu Manager menus. This does 
not affect the display of picks being made in menu bar menus or dialog boxes.

no / yes

visible_message_lines Sets the default number of visible message lines in the Pro/ENGINEER message area.

vrml_anchor_url
Enables you to place an anchor on a specified VRML component during the export to VRML. The 
keywords are optional.

vrml_background_color Yes - Exports a model to VRML with the Pro/ENGINEER background color. yes / no
vrml_explode_lines Yes - Exports a model to VRML with explode lines for assembly or assembly process data. yes / no
vrml_explode_lines Yes - Exports a model to VRML with explode lines for assembly or assembly process data. yes / no
vrml_export_resolution Specifies the number of levels of detail (LODs) in models exported in VRML format. high / medium / low
vrml_export_version Controls the VRML version for export. 2.0 / 1.0

vrml_file_duplicate_material
Yes - Ensures that the model components retain their true color. No - In some viewers, component 
colors might not be consistent.

yes / no
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vrml_file_duplicate_material
Yes - Ensures that the model components retain their true color. No - In some viewers, component 
colors might not be consistent.

yes / no

vrml_multiple_views
All - Exports top-level and lower-level assembly component views into VRML format. None - Does 
not export component views into VRML format. Top - Exports top-level object view only into VRML 
format.

none / all / top

vrml_parameters
Controls the export of user parameters. Designated - Export only designated parameters. All - 
Export all parameters. None - Do not export parameters.

designated / all / none

vrml_simprep_export
Yes - Specifies direct and in memory export of top-level assembly simplified representation to 
Pro/FLY-THROUGH package files.

yes / no

warn_for_unlocked_obj
Issues you a warning when you fetch, retrieve or modify a Pro/PDM object that has not been 
locked.

yes / no

web_browser_history_days Enter number of days to store history records.
web_browser_homepage Enter location of Pro/E browser home page.
web_disable_js_command Enter a specific javascript command to be disabled
web_enable_javascript Enables or disables Pro/Web.Link in the embedded browser. on / off
web_enable_subscription Enable the subscription mechanism for Connections no / yes
web_link_file_read Sets Pro/Web.Link permission to read data from the local file system. yes / no
web_link_file_write Sets Pro/Web.Link permission to write data to the local file system. yes / no
web_link_proe_read Sets Pro/Web.Link permission to read data from a Pro/ENGINEER session. yes / no
web_link_proe_write Sets Pro/Web.Link permission to modify data in a Pro/Engineer session. yes / no

web_link_security_autoprompt
Yes - The Security dialog box is displayed when a Pro/Web.Link function requires security access 
beyond the current settings.

yes / no

web_max_mail_size Set the maximum email attachment size in kilobytes.

weld_ask_xsec_refs
No - Do not ask for X-section references when creating weld features. Yes - Ask for X-section 
references when creating weld features.

no / yes

weld_color
Defines default weld color. The three decimal values specify (in order) percentage of red, green 
and blue in the resulting color. For example, 0 0 49 specifies a medium blue. Change in session 
using Tools>Colors>System.

weld_dec_places Sets the default number of decimal places (0-10) to display in weld parameters.
weld_edge_prep_driven_by Determines if the edge preparation feature is created in the part or the assembly level. part / assembly
weld_edge_prep_groove_angle Specifies an initial default value for the angle cut edge preparation.
weld_edge_prep_groove_depth Specifies an initial default value for the edge preparation depth.

weld_edge_prep_instance
Controls whether a family table instance is created for edge preparation. Yes - Instances of the 
components that receive edge preparation are created.

yes / no

weld_edge_prep_name_suffix
Specifies the suffix name for the instance that will be created during edge preparation. Part name 
plus extension makes the instance name.

weld_edge_prep_root_open Specifies an initial default value for the root opening edge preparation.

weld_edge_prep_visibility
Applies only if weld_edge_prep is set to Yes. Generic - Edge preparation features are resumed in 
the generic and suppressed in the instance. Instance - Edge preparation features are suppressed 
in the generic and resumed in the instance.

generic / instance

weld_notch_corner_radius Specifies an initial default value for the radius at weld notch corner.
weld_notch_height Specifies an initial default value for the weld notch height.

39 of 40 www.ptc.com ©2003, Parametric Technology Corporation ( PTC)



Name Description Values
weld_notch_radius Specifies an initial default value for the weld notch radius.
weld_notch_width Specifies an initial default value for the weld notch width.

weld_ui_standard
Specifies standard for welding user interface. ANSI - Use ANSI standards. ISO - Use ISO 
standards.

iso / ansi

windows_scale
Scales Pro/ENGINEER windows with a given coefficient. A value of 0.85 is usually adequate to 
allow dynamic menus to display to the right of the Pro/ENGINEER window. Refer to 
menu_horizontal_hint.

www_add_aux_frame
Creates additional frame for each process step or for assembly publication. Yes - Auxiliary files 
aux.html are created for each step in assembly process (in each step00 directory) to be replaced 
by your .html file. No - Auxiliary files are not created.

no / yes

www_export_geometry_as Specifies the output format by to one of the values
vrml / cgm / jpg / cgm_vrml / 
jpg_vrml / cgm_jpg / all

www_multiple_views
All - Writes all views in any component to the appropriate VRML files. Top - Writes only named 
views that reside in the assembly or process assembly to top-level VRML files. None - Does not 
write named views to VRML files.

none / all / top

www_tree_location
Specifies the location of the model tree in the browser window. Out - Opens model tree in a 
separate window. In - Includes model tree in the Web page and removes the Tree checkbox from 
the control panel.

out / in

x_angle
Sets the default view orientation for models (appears in the Orientation dialog box). The default 
orientation is the last option, x_angle, y_angle, or orientation, in the configuration file.

y_angle
Sets the default view orientation for models (appears in the Orientation dialog box). The default 
orientation is the last option, x_angle, y_angle, or orientation, in the configuration file.
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